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Scott Kelby is Editor of 
Photoshop User maga- 
zine, Training Director 
for the Adobe Photoshop 
Seminar Tour, President 
of the training, educa- 
tion, and publishing firm, 
KelbyOne, Inc., and one 
of the leading seminar 
instructors in the industry 

today. Scott is author of the best-selling 
books The Adobe Photoshop Lightroom 5 
Book for Digital Photographers, Photo-
shop for Lightroom Users, and The Digital 
Photography Book (parts 1, 2, 3, 4 and 5), 
among others. His easygoing, plain-English 
style of teaching makes learning Photoshop 
fun. He trains thousands in his live seminars 
each year and knows firsthand which tech- 
niques are in hot demand, and now he shares 
them here in his latest book.

ARE YOU READY FOR AN AMAZING NEW VERSION  
OF THE PHOTOSHOP BOOK THAT BREAKS ALL THE RULES?

Scott Kelby, Editor and Publisher of Photoshop User magazine—and the best-selling  
photography book author in the world today—once again takes this book to a whole  
new level as he uncovers more of the latest, most important, and most useful Adobe  
Photoshop techniques for digital photographers.

This update to his award-winning, record-breaking book does something for digital 
photographers that’s never been done before—it cuts through the bull and shows you  
exactly “how to do it.” It’s not a bunch of theory; it doesn’t challenge you to come up  
with your own settings or figure it out on your own. Instead, Scott shows you step by  
step the exact techniques used by today’s cutting-edge digital photographers, and  
best of all, he shows you flat-out exactly which settings to use, when to use them,  
and why. That’s why the previous editions of this book are widely used as the official  
study guide in photography courses at colleges and universities around the world.

LEARN HOW THE PROS DO IT
Each year, Scott trains thousands of professional photographers on how to use  
Photoshop, and almost without exception they have the same questions, the  
same problems, and the same challenges—and that’s exactly what he covers  
in this book. You’ll learn:

	 •  The sharpening techniques the pros really use.

	 •  The pros’ tricks for fixing the most common digital photo problems fast!

	 • � How to process HDR (High Dynamic Range) images to get realistic-  
looking images, as well as the heavily tone-mapped hyperreal look.

	 • � How to master Photoshop’s Content-Aware features.

	 • � How to use Photoshop’s video editing features to make movies from 
your DSLR videos.

	 • � How to process RAW images like a pro (plus how to take advantage of  
all the new Camera Raw features in CC).

	 • � The latest Photoshop special effects for photographers (there’s a whole  
chapter just on these!).

	 • � A host of shortcuts, workarounds, and slick “insider” tricks to send your  
productivity through the roof!

Plus, Scott includes a special chapter with his own workflow, from start to finish,  
and each chapter ends with a Photoshop Killer Tips section, packed with time-saving,  
job-saving tips that make all the difference. He also provides four bonus chapters, along  
with all the images used in the book for download on the book’s companion webpage.

If you’re a digital photographer, and if you’re ready to learn all the “tricks of the trade”— 
the same ones that today’s leading pros use to correct, edit, retouch, and sharpen their 
work—then you’re holding the book that will do just that.

http://kelbyone.comwww.newriders.com
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This book is dedicated to my friend Erik Kuna,
for working so hard, caring so much,

and for doing it all for the right reasons.
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I’ve been writing books for 17 years now, and I still find that the thing that’s the hardest for me to write in any book is 

writing the acknowledgments. It also, hands down, takes me longer than any other pages in the book. For me, I think the 

reason I take these acknowledgments so seriously is because it’s when I get to put down on paper how truly grateful I am 

to be surrounded by such great friends, an incredible book team, and a family that truly makes my life a joy. That’s why it’s 

so hard. I also know why it takes so long—you type a lot slower with tears in your eyes.

To my remarkable wife, Kalebra: We’ve been married 25 years now, and you still continue to amaze me, and everyone 

around you. I’ve never met anyone more compassionate, more loving, more hilarious, and more genuinely beautiful, and  

I’m so blessed to be going through life with you, to have you as the mother of my children, my business partner, my private 

pilot, Chinese translator, and best friend. You truly are the type of woman love songs are written for, and as anyone who 

knows me will tell you, I am, without a doubt, the luckiest man alive to have you for my wife.

To my son, Jordan: It’s every dad’s dream to have a relationship with his son like I have with you, and I’m so proud of the 

bright, caring, creative young man you’ve become. I can’t wait to see the amazing things life has in store for you, and I just 

want you to know that watching you grow into the person you are is one of my life’s greatest joys.

To my precious little girl, Kira: You have been blessed in a very special way, because you are a little clone of your mom, which  

is the most wonderful thing I could have possibly wished for you. I see all her gifts reflected in your eyes, and though you’re 

still too young to have any idea how blessed you are to have Kalebra as your mom, one day—just like Jordan—you will.

To my big brother Jeff, who has always been, and will always be, a hero to me. So much of who I am, and where I am, is  

because of your influence, guidance, caring, and love as I was growing up. Thank you for teaching me to always take the 

high road, for always knowing the right thing to say at the right time, and for having so much of our dad in you.

I’m incredibly fortunate to have part of the production of my books handled in-house by my own book team at Kelby Media 

Group, which is led by my friend and longtime Creative Director, Felix Nelson, who is hands down the most creative person  

I’ve ever met. He’s surrounded by some of the most talented, amazing, ambitious, gifted, and downright brilliant people I’ve 

ever had the honor of working with, and thank God he had the foresight to hire Kim Doty, our Managing Editor, and the only 

reason why I haven’t totally fallen onto the floor in the fetal position by the time a book is done. Kim is just an incredibly orga-

nized, upbeat, focused person who keeps me calm and on track, and no matter how tough the task ahead is, she always says 

the same thing, “Ah, piece of cake,” and she convinces you that you can do it, and then you do it. I cannot begin to tell you 

how grateful I am to her for being my Editor, and to Felix for finding her. I guess great people just attract other great people. 

Working with Kim is Cindy Snyder, who relentlessly tests all the stuff I write to make sure I didn’t leave anything out, so you’ll 

all be able to do the things I’m teaching (which with a Photoshop book is an absolute necessity). She’s like a steel trap that 

nothing can get through if it doesn’t work just like I said it would. 
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The look of the book comes from an amazing designer, a creative powerhouse, and someone whom I feel very, very lucky 

to have designing my books—Jessica Maldonado. She always adds that little something that just takes it up a notch, and 

I’ve built up such a trust for her ideas and intuition, which I why I just let her do her thing. Thanks Jess! 

Huge thanks to my Executive Assistant Lynn Miller, who has only been working with me for a little while now, but she’s 

absolutely awesome and runs a whole side of my business life and makes sure I’m where I’m supposed to be, working 

on what I’m supposed to be doing. She generally herds me like sheep to keep me focused so I have time to write books, 

spend time with my family, and have a life outside of work. So glad to have you on my team.

To my best buddy and book-publishing powerhouse, Dave Moser (also known as “the guiding light, force of nature,  

miracle birth, etc.”), for always insisting that we raise the bar and make everything we do better than anything we’ve 

done before.

Thanks to everyone at New Riders and Peachpit, and in particular to my way cool Editor, Ted Waitt (who is one heck of a 

photographer and a vitally important part of everything I do in “Bookland”), my wonderful Publisher Nancy Aldrich-Ruenzel, 

marketing maven Scott Cowlin, marketing diva Sara Jane Todd, and the entire team at Pearson Education who go out of 

their way to make sure that we’re always working in the best interest of my readers, that we’re always trying to take things 

up a notch, and who work hard to make sure my work gets in as many people’s hands as possible.

Thanks to my friends at Adobe: Winston Henderickson, Bryan O’Neil Hughes, Mala Sharma, Terry White, Jim Heiser, Julieanne 

Kost, Tom Hogarty, Scott Morris, Russell Preston Brown, Bryan Lamkin, and the amazing engineering team at Adobe (I don’t 
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Seven Things 
You’ll Wish You  

Had Known Before 
Reading This Book

It’s really important to me that you get a lot out of reading this book, and one  
way I can help is to get you to read these seven quick things about the book that 
you’ll wish later you knew now. For example, it’s here that I tell you about where  
to download something important, and if you skip over this, eventually you’ll send me 
an email asking where it is, but by then you’ll be really aggravated, and well… 
it’s gonna get ugly. We can skip all that (and more), if you take two minutes now  
and read these seven quick things. I promise to make it worth your while.

(1) �You don’t have to read  
this book in order.

I designed this book so you can turn right 
to the technique you want to learn, and 
start there. I explain everything as I go, 
step-by-step, so if you want to learn how 
to remove dust spots from a RAW image, 
just turn to page 70, and in a couple of 
minutes, you’ll know. I did write the book 
in a logical order for learning Photoshop, 
but don’t let that tie your hands—jump 
right to whatever technique you want  
to learn—you can always go back, re-
view, and try other stuff.

(2) �Practice along with the same  
photos I used here in the book.

As you’re going through the book, and 
you come to a technique like “Creating 
the Tone-Mapped HDR Look,” you might 
not have an HDR-bracketed set of shots 
hanging around, so in those cases I usu-
ally made the images available for you to 
download, so you can follow along with 
the book. You can find them at http://
kelbyone.com/books/cc14 (see, this is 
one of those things I was talking about 
that you’d miss if you skipped this and 
went right to Chapter 1).
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(3) �The intro pages at the beginning 
of each chapter are not what 
they seem.

The chapter introductions are designed to 
give you a quick mental break between 
chapters, and honestly, they have little to 
do with what’s in the chapter. In fact, they 
have little to do with anything, but writing 
these quirky chapter intros has become 
kind of a tradition of mine (I do this in all 
my books), so if you’re one of those really 

“serious” types, I’m begging you—skip 
them and just go right into the chapter 
because they’ll just get on your nerves. 
However, the short intros at the beginning 
of each individual project, up at the top of 
the page, are usually pretty important. If 
you skip over them, you might wind up  
missing stuff that isn’t mentioned in the 
project itself. So, if you find yourself work-
ing on a project, and you’re thinking to 
yourself, “Why are we doing this?” it’s 
probably because you skipped over that 
intro. So, just make sure you read it first, 
and then go to Step One. It’ll make a 
difference—I promise.

(4) �There are things in Photoshop 
CC and in Camera Raw that  
do the exact same thing.

For example, there’s a Lens Corrections 
panel in Camera Raw, and there’s a Lens 
Correction filter in Photoshop, and they 
are almost identical. What this means to 
you is that some things are covered twice 
in the book. As you go through the book, 
and you start to think, “This sounds fa-
miliar…,” now you know why. By the way, 
in my own workflow, if I can do the exact 
same task in Camera Raw or Photoshop, 
I always choose to do it in Camera Raw, 
because it’s faster (there are no progress 
bars in Camera Raw) and it’s non-destruc-
tive (so I can always change my mind later).

S
C

O
T

T
 K

E
L

B
Y

The Adobe Photoshop CC Book for Digital Photographers (2014 Release) 

The Adobe Photoshop CC Book for Digital Photographers (2014 Release)xiv The Adobe Photoshop CC Book for Digital Photographers (2014 Release) xvThe Adobe Photoshop CC Book for Digital Photographers (2014 Release)xiv



(5) �I included a chapter on my CC  
workflow, but don’t read it yet.

At the end of this book I included a spe-
cial chapter detailing my own Photoshop 
CC workflow, but please don’t read it  
until you’ve read the rest of the book, 
because it assumes that you’ve read the 
book already, and understand the basic 
concepts, so it doesn’t spell everything 
out (or it would be one really, really long 
drawn-out chapter). 

(6) Where’s the Bridge stuff?
Adobe hasn’t updated Bridge for  
years now. Well, I guess that’s not  
exactly true—they removed some  
stuff, but outside of that—that’s pretty 
much it. Wait…wait…back in Photoshop 
CS6 they added a “Mini Bridge” to 
Photoshop so you can could access  
your images without leaving Photoshop. 
Oh. That’s right—in Photohsop CC they 
even removed Mini Bridge. I’m thinking 
the future of Bridge is not bright, and 
since it hasn’t really changed in years, 
I’m no longer including it here in the book, 
but if you’re brand new to Photoshop, you 
don’t use Lightroom and you think you 
might need Bridge, I did write two entire 
chapters just on Bridge and put them 
on the book’s download site for you to 
download free. You’ll find these at http://
kelbyone.com/books/cc14, along with 
another bonus chapter on printing (see,  
I care).
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(7) �Photography is evolving,  
Photoshop is evolving, and  
this book has to, too.

This is the second edition of this book 
that doesn’t include a chapter on using 
Curves, and that’s because today we use  
a different tool—Camera Raw (even if we  
don’t shoot in RAW, because it works 
for JPEGs and TIFFs, too!). I spent years 
teaching Curves in books and in podcasts 
and here in this book, but honestly, today 
I really don’t use Curves (and if I do, I use 
the Tone Curve in Camera Raw, which  
I do cover here in the book). In fact, I had 
a hard time finding any photographers  
I know still using Curves, which just shows 
how Photoshop has evolved over time. 
Although Curves isn’t covered here in 
the book, I did provide a color correction 
chapter using Curves on the book’s down-
loads page (ya know, just in case you want 
to go “old school”). You can find it at the 
web address just mentioned in #6.

(8) �Each chapter includes my 
“Photoshop Killer Tips”!

Hey, I thought you said it was “Seven 
Things”? Well, consider this eighth a 
“bonus thing,” because it’s about an-
other bonus I included in this edition of 
the book. At the end of every chapter is 
a special section I call “Photoshop Killer 
Tips” (named after the book of the same 
name I did a few years ago with Felix 
Nelson). These are those time-saving, 
job-saving, “man, I wish I had known that 
sooner” type tips. The ones that make 
you smile, nod, and then want to call all 
your friends and “tune them up” with your 
new status as Photoshop guru. These are 
in addition to all the other tips, which 
already appear throughout the chapters 
(you can never have enough tips, right? 
Remember: He who dies with the most 
tips, wins!). So, there you have it, seven 
(or so) things that you’re now probably 
glad you took a couple minutes to read. 
Okay, the easy part is over—turn the  
page and let’s get to work.
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Chapter 4 How to Resize and Crop Photos

I love the title of this chapter—it’s the name of an album 

from the band Soulfarm (tell me that Soulfarm wouldn’t 

make a great name for a horror movie!). Anyway, I also 

found a band named Cash Crop, which would make a great 

title, too, but when I looked at their album, every song was 

marked with the Explicit warning. I listened to a 90-second 

preview of the first track (which was featured in the original 

motion picture soundtrack for the movie Sorority Row), and  

I immediately knew what kind of the music they did. Naughty, 

naughty music. Anyway, while I was listening, and wincing 

from time to time as F-bombs exploded all around me,  

I realized that someone at the iTunes Store must have the 

full-time job of listening to each song and choosing the 

90-second preview. I imagine, at this point, that person has 

to be 100% completely numb to hearing things like the 

F-bomb, the S-missile, and the B-grenade (which means 

they could totally do a stint as Joe Pesci’s nanny). But,  

I digress. The “Scream of the Crop” title (which would make 

a great title for a movie about evil corn) is almost ideal 

for this chapter, except for the fact that this chapter also 

includes resizing. So, I thought, what the heck, and searched 

for “resize” and found a song called “Undo Resize” by 

electronic ambient artist DJ Yanatz Ft. The Designers, and 

it literally is an 8:31 long background music track with two 

European-sounding women whispering the names of menu 

commands from Adobe products. Stuff like “Select All,” 

“Fill,” “Distort,” “Snap to Grid,” and so on. I am not making 

this up (I listened to the free 90-second preview). It was 

only 99¢, which was a bargain for 8+ minutes of menu 

commands set to music. Normally, this many minutes  

of menu commands set to music would be more like,  

I dunno, $1.29 or so.

Scream of the Crop 
how to resize and crop photos
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Step One:
Press the letter C to get the Crop tool 
and you instantly see the first improve-
ment over previous versions of the tool: 
you don’t have to drag the cropping  
border out over your photo—it’s auto-
matically added around your image for 
you (yay!). Now, just grab one of the cor-
ner or side handles and start dragging 
inward to start cropping (as shown here) 
and it crops in toward the center of the 
image (the area to be cropped away will 
appear dimmed). If you want to keep the 
image proportions the same in your crop 
(I usually do), just press-and-hold the 
Shift key while you drag any of the crop-
ping handles. Also, you can reposition 
your image within the border by clicking-
and-dragging on it.

Step Two:
The Rule of Thirds overlay grid that you 
see in Step One doesn’t appear over your 
photo until you actually drag one of the 
cropping handles. If you see a different 
overlay, just click on the Overlay Options 
icon in the Options Bar (it’s to the right of 
the Straighten tool) and you’ll get a pop-
up menu of the different overlays you 
can choose (if you’re not sure which one 
you want, you can cycle through them 
by pressing the letter O). There are also 
three overlay settings in the menu: Al-
ways Show Overlay (once you start crop-
ping, it’s visible even when you’re not 
cropping), Never Show Overlay, and Auto 
Show Overlay (my favorite—it only ap-
pears when you’re actually cropping).

Adobe completely overhauled cropping in Photoshop CS6, and it was a big  
improvement (it was long overdue, since aside from a few minor enhancements, 
cropping had been essentially unchanged since Photoshop 1.0). Here, we’ll cover 
the basic garden-variety cropping (and a new way of cropping), but since there are 
many different ways to crop a photo in Photoshop (and different reasons why you’d 
use one over another), we’ll cover them all. If you’re a Lightroom user, you’ll be 
right at home with this cropping, because it works more like Lightroom’s cropping.

Basic Cropping
 for Photos
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Step Three:
While you have the cropping border in 
place, if you need to rotate your photo, 
just move your cursor anywhere outside 
the border. When you do this, the cursor 
will change into a double-headed arrow. 
Just click, hold, and drag up (or down) 
and the image will rotate in the direc-
tion you choose (rather than the cropping 
border). This makes the process much 
easier (especially when you’re trying to 
straighten a horizon line or a building). A 
little pop-up appears, too, with the angle 
of rotation (it’s shown circled here in red).

Step Four:
If you decide you want to return to the 
old way of rotating your crop (where the 
border rotates, rather than your image), 
click on the Set Additional Crop Options 
icon (it looks like a gear) in the Options 
Bar and turn on the Use Classic Mode 
checkbox (also known as “old school” 
or “ancient cropping” by today’s hip
ster croppers), and then you’re back to  
the old method. However, I really rec
ommend giving this newer way a try— 
it takes a little getting used to, but once 
you do, you’ll really find it useful. While 
we’re in this options menu, when you’re 
not in Classic mode, you have two op-
tions available here: (1) to turn off having 
your crop centered automatically (it’s 
on by default), and we’ll talk about the 
next one on the next page (it’s a little 
more involved).
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Step Five:
That other option (2) is more powerful 
than it sounds, because it pretty much 
brings one of the most popular cropping 
features of Lightroom over here to Photo
shop. In Lightroom, it’s called Lights Out 
cropping, and when you use this, it blacks 
out everything surrounding your crop 
area, so as you drag a cropping handle, 
you see exactly what the final image will 
look like without any distractions. If you 
click on the Set Additional Crop Options 
icon, you can toggle this on/off with the 
Show Cropped Area checkbox, but hon-
estly it’s quicker just to press the letter H  

on your keyboard (it’s easy to remember— 
H for hide the distracting stuff; click on a 
cropping handle first or it’ll switch to the 
Hand tool). Want to take it up a notch? 
Once you’ve hidden the extra stuff, hit 
the Tab key on your keyboard and every-
thing else (the Toolbox, panels, Options  
Bar, etc.) hides temporarily, too. The other 
options here only kick in if you do have 
that dimmed cropped away area visible  
(called the Crop Shield), and you can 
make it lighter or darker by changing the 
Opacity amount, or you can turn it off 
altogether by turning off the Enable Crop 
Shield checkbox.

Step Six:
If you want to save some time, there’s 
a list of preset standard cropping sizes 
in the pop-up menu at the left end of 
the Options Bar (seen here). Just choose 
the crop ratio you’d like (here, I chose a 
square 1:1 ratio), and your crop border 
automatically resizes to that size or ratio 
(as shown here).
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Step Seven:
If you decide at some point you don’t 
want to crop the image at all, you can  
either press the Esc key on your key-
board, click on the “No!” symbol in the 
Options Bar (as shown here), or just click 
on a different tool in the Toolbox, which 
will bring up a dialog asking if you want  
to crop the image or not.

TIP: Flipping Your Crop  
Horizontal/Vertical
Want to flip the cropping border after 
you’ve clicked-and-dragged it out, so 
you can crop your wide photos with a tall 
crop that maintains the same aspect ratio 
(or vice versa)? Just press the letter X 
on your keyboard.

Step Eight:
So far, we’ve looked at the standard way 
of cropping—click on the tool and then 
drag the handles where you want them—
but you can also use the freestyle way 
of cropping (like in previous versions of 
Photoshop) by taking the Crop tool itself 
and just clicking-and-dragging over the 
area you want to crop (as shown here). 
Don’t let it freak you out that there’s a 
cropping border already in place—just 
click-and-drag it out, and when you re-
lease the mouse button, it will display 
your new cropping border. Of course, 
now you can tweak the handles just like  
before. If you go back and look at the 
original image in Step One, you’ll see 
how much we’ve already cropped away 
(it’s quite a bit).
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Step Nine:
You can also add canvas area around 
your image using the Crop tool. One 
quick thing to check first: if you want a 
white background for your canvas area 
(and my guess is, most times you will), 
then before you even click on the Crop 
tool, press the letter D on your keyboard 
to set your Background color to white. 
Then, once you click on the Crop tool, 
make sure Ratio is selected in the pop-
up menu at the left end of the Options 
Bar and you click the Clear button to clear 
the Width and Height fields, otherwise 
the cropping border will be constrained 
to the aspect ratio of your image (in this 
case, we want the bottom section to be 
deeper than the sides and top). Now, 
grab a cropping handle and drag the 
border outward to add canvas area. 
Here, I clicked on the top-left cropping 
handle and dragged up and to the left 
(at a 45° angle), and it expanded the top 
and left side areas around my image.

Step 10:
Here, I dragged the right side out and 
then dragged the bottom-center handle 
down quite a bit to add a fine art poster 
mat look around my image.

TIP: Skip Holding the Shift Key
You already know that to keep your 
cropping proportional, you press-and-
hold the Shift key, right? Here’s how to 
skip having to hold that key ever again, 
yet still keep it proportional: close any 
open images, grab the Crop tool, and 
then choose Original Ratio from the 
pop-up menu at the left end of the  
Options Bar. Now, it’s your default  
setting. How cool is that?
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Step 11:
Before you actually commit to cropping 
your image, you have a decision to make. 
Luckily, it’s probably a decision you’ll 
make once, based on how you like to do 
things, so you won’t have to make it every 
time. You get to decide if the part of your 
image that gets cropped away from view 
is: (a) gone forever, or (b) just hidden from 
view and, if necessary, can be brought 
back. You choose this by turning on/off 
the Delete Cropped Pixels checkbox up 
in the Options Bar (shown circled here in 
red). With it turned on, when you crop, 
the stuff outside the border is cropped 
away (and you get a smaller file size). If 
you turn if off, it keeps those areas in the 
file, even though you can’t see them (well, 
not until you click on the Crop tool again 
and click-and-drag the cropping border 
back out). If you need the photo a specific 
size, but aren’t happy with the way your 
first crop looks, you can move the image 
around with the Move tool (V), or click 
on the cropping border while the Crop 
tool is active, then click on the image and 
move it.

Step 12:
Once you have the cropping border right 
where you want it, press the Return (PC: 

Enter) key to crop your image. The final 
cropped image is shown here, where we  
cropped off the signs on the top and the 
field on the bottom, the cameraman and 
player on the far left, and the crowd and 
players on the right.
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Step One:
Here’s the image I want to print as a  
wide 20x16" print (a very common size 
today, even though it’s based on the size 
of traditional film, not digital images, so 
you have to crop just to make it fit). Start 
by clicking on the Crop tool (C) in the 
Toolbox, then from the pop-up menu at 
the left end of the Options Bar, choose 
W x H x Resolution (as shown here).

Step Two:
This adds a Resolution field to the  
Options Bar next to the Width and 
Height fields. Type in the custom size you 
want (in this case, 20x16" at a resolution 
of 240 ppi, which is pretty ideal for most 
color inkjet printing) and it resizes auto-
matically. If you think you’ll be using this  
size again (and chances are, you will), click 
on the pop-up menu and choose New 

Crop Preset, name it, click OK, and it 
adds this new size to that pop-up menu, 
so you don’t have to recreate it every time. 
You can click-and-drag the photo left/right 
to get the part of it you want to appear 
inside the cropping border. Now press 
the Return (PC: Enter) key and it crops 
your image to that size.

If you’re using one of the standard size or cropping ratio presets that appear  
in the Crop tool’s pop-up menu, then you’re set. However, there are only a few  
common sizes in that pop-up menu, so you’re going to need to know (a) how to  
create custom sizes, and (b) how to save that custom size to the pop-up menu,  
so you don’t have to build it from scratch again next time. Plus, I’m going to show 
you another way to crop an image that, well, I’m not proud of, but I know a lot of 
photographers that do it this way. (Now, I’m not saying that I’ve done it that way, 
but…well…I’ve done it that way. More times than I care to admit.)

Cropping to a  
Specific Size
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Step Three:
Okay, here’s that (ahem) other method: 
Go under the File menu and choose New 
(or press Command-N [PC: Ctrl-N]).  
When the New dialog appears, enter 20 
inches by 16 inches, and enter 240 for 
Resolution, then click OK to create a new 
blank document in the exact size and 
resolution you need (as seen here).

TIP: Cropping to Another  
Photo’s Size
If you already have a photo that is the 
exact size and resolution that you’d  
like to apply to other images, you can 
use its settings as the crop dimensions. 
First, open the photo you’d like to resize, 
and then open your ideal-size-and-res-
olution photo. Get the Crop tool, and 
then from the pop-up menu at the left 
end of the Options Bar, choose Front 

Image. Photoshop will automatically 
input that photo’s dimensions into the 
Crop tool’s Width, Height, and Resolu-
tion fields. All you have to do is click 
back on the other image, and you'll see 
a cropping border that shares the exact 
same specs as your ideal-size photo.

Step Four:
Now, get the Move tool (V), click on  
the image you want cropped to that size, 
and drag it onto that new blank docu-
ment. While you still have the Move tool, 
click-and-drag the image around within 
the window so it’s cropped the way you 
want it, then press Command-E (PC: 

Ctrl-E) to merge this layer with the Back-
ground layer, and you’re set. As you can 
see, they both kind of do the exact same 
thing, so which one’s right? The one you 
like best.
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Step One:
Press the letter C to switch to the Crop 
tool, and then go under the Window 
menu and choose Tool Presets to bring 
up the Tool Presets panel. You’ll find that 
five Crop tool presets are already there. 
(Make sure that the Current Tool Only 
checkbox is turned on at the bottom of 
the panel, so you’ll see only the Crop 
tool’s presets, and not the presets for 
every tool.)

Step Two:
Go up to the Options Bar and, with the 
pop-up menu set to Ratio, enter the 
dimensions for the first tool you want 
to create (in this example, we’ll create 
a Crop tool that crops to a wallet-size 
image). In the Width field, enter 2 in, 
then press the Tab key to jump to the 
Height field, enter 2.5 in, and press  
Return (PC: Enter). Note: If you want to 
include the resolution in your tool preset, 
from the pop-up menu, choose W x H 

x Resolution. Enter your height, width, 
and resolution in the fields to the right  
of the pop-up menu, and click OK.

Although it’s more of an advanced technique, creating your own custom tools  
isn’t complicated. In fact, once you set them up, they will save you time and money. 
We’re going to create what are called “tool presets.” These tool presets are a series  
of tools (in this case, Crop tools) with all our option settings already in place, so we  
can create a 5x7", 6x4", or whatever size Crop tool we want. Then, when we want to 
crop to 5x7", all we have to do is grab the 5x7" Crop tool preset. Here’s how:

Creating Your  
Own Custom  

Crop Tools
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Step Three:
In the Tool Presets panel, click on  
the Create New Tool Preset icon at the 
bottom of the panel (to the left of the 
Trash icon). This brings up the New Tool 
Preset dialog, in which you can name 
your new preset. Name it, click OK, and 
the new tool is added to the Tool Presets 
panel. Continue this process of typing in 
new dimensions in the Crop tool’s Op-
tions Bar and clicking on the Create New 
Tool Preset icon until you’ve created cus-
tom Crop tools for the sizes you use most. 
Make sure the name is descriptive (for 
example, add “Portrait” or “Landscape”). 
If you need to change the name of a 
preset, just double-click directly on its 
name in the panel, and then type in a 
new name.

Step Four:
Chances are your custom Crop tool  
presets won’t be in the order you want 
them, so go under the Edit menu, under 
Presets, and choose Preset Manager. 
In the resulting dialog, choose Tools from 
the Preset Type pop-up menu, and scroll 
down until you see the Crop tools you 
created. Now just click-and-drag them  
to wherever you want them to appear  
in the list, and then click Done.

Step Five:
Now you can close the Tool Presets panel 
because there’s an easier way to access 
your presets: With the Crop tool selected, 
just click on the Crop icon on the left end 
of the Options Bar. A tool preset picker 
will appear. Click on a preset, and your 
cropping border will be fixed to the exact 
dimensions you chose for that tool.
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Step One:
Start by going under the Photoshop 
(PC: Edit) menu, under Preferences, and 
choosing Sync Settings (as shown here) 
to go directly to the preference settings 
for syncing (also shown here). By default, 
it assumes you want all your stuff synced, 
but if you’d prefer to not have one or 
more of the options synced, set the What 
To Sync pop-up menu to Custom, and 
just turn off those checkboxes.

Step Two:
If the date of your Last Sync was quite 
a while ago (time flies when you’re not 
syncing), you can go under the Photo-
shop (PC: Edit) menu, under your Adobe 
ID, and choose Upload Settings and it 
will update your Creative Cloud settings 
with your current ones (it only updates 
any settings you’ve changed since your 
last sync). Okay, so how do you use all of 
this on a different computer? Well, you 
start in the Help menu, where you choose 

Manage My Account, sign in to your 
Creative Cloud account, and then go  
back under your Adobe ID and choose 
Download Settings.

Imagine being able to sit down at a friend’s or co-worker’s computer to do some 
Photoshop work and, within seconds, you have all your own brushes, swatches,  
actions, patterns, and more, so it’s just like working in your version of Photoshop, your 
way. Or, wouldn’t it be nice to have your laptop’s and your desktop’s settings  
exactly alike? You can do just that by syncing your important settings with the 
Creative Cloud, so they’re always just one click away (plus, now you have a copy  
of your important settings backed up to the cloud, so if your hard drive dies  
or your computer gets lost or stolen, you can quickly get back up and running).

Sync Settings
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Step One:
Go under the File menu and choose 
New (or press Command-N [PC: Ctrl-

N]). When the New dialog appears, click 
on the Preset pop-up menu to reveal the 
list of preset types, and choose Photo. 
Then click on the Size pop-up menu to 
see the preset sizes, which include 2x3",  
4x6", 5x7", and 8x10" in both portrait and 
landscape orientation. The only problem 
with these is that their resolution is set 
to 300 ppi by default. So, if you want a 
different size preset at less than 300 ppi, 
you’ll need to create and save your own.

Step Two:
For example, let’s say that you want a 5x7" 
set to landscape (that’s 7" wide by 5" tall). 
First, choose Photo from the Preset pop-
up menu, then choose Landscape, 5x7 
from the Size pop-up menu. Choose your 
desired Color Mode (below Resolution) 
and Color Profile (under Advanced), and 
then enter a Resolution (I entered 212 ppi, 
which is enough for me to have my image 
printed on a high-end printing press). 
Once your settings are in place, click  
on the Save Preset button.

Photoshop’s dialog for creating new documents has a pop-up menu with a list  
of preset sizes. You’re probably thinking, “Hey, there’s a 4x6", 5x7", and 8x10"— 
I’m set.” The problem is there’s no way to switch the resolution of these presets  

(so the Portrait, 4x6 will always be a 300 ppi document). That’s why creating  
your own custom new document sizes is so important. Here’s how:

Custom Sizes for 
Photographers
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Step Three:
This brings up the New Document Preset 
dialog. In the Preset Name field, enter 
your new resolution at the end of the size. 
You can turn on/off the checkboxes for 
which parameters you want saved, but 
I use the default setting to include every-
thing (better safe than sorry, I guess).

Step Four:
Click OK and your new custom preset will 
appear in the New dialog’s Preset pop-up 
menu. You only have to go through this 
once. Photoshop will remember your cus-
tom settings, and they will appear in this 
Preset pop-up menu from now on.

Step Five:
If you decide you want to delete a preset,  
it’s simple—just open the New dialog, 
choose the preset you want to delete 
from the Preset pop-up menu, and then 
click the Delete Preset button. A warning 
dialog will appear asking you to confirm 
the delete. Click Yes, and it’s gone!
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Step One:
Open the digital camera image that you 
want to resize. Press Command-R (PC: 

Ctrl-R) to make Photoshop’s rulers visible. 
As you can see from the rulers, the photo 
is about 59" wide by 39" high.

Step Two:
Go under the Image menu and choose 
Image Size (or press Command-Option-

I [PC: Ctrl-Alt-I]) to bring up the Image 
Size dialog. As you can see here, the 
Resolution setting is 72 ppi. A resolution 
of 72 ppi is considered “low resolution” 
and is ideal for photos that will only be 
viewed onscreen (such as web graphics, 
slide shows, and so on), but it’s too low to 
get high-quality results from a color inkjet 
printer, color laser printer, or for use on a 
printing press.

If you’re used to resizing scans, you’ll find that resizing images from  
digital cameras is a bit different, primarily because scanners create high-res  

scans (usually 300 ppi or more), but the default settings for many digital cameras  
produce an image that is large in physical dimensions, but lower in pixels-per-inch 
(usually 72 ppi). The trick is to decrease the physical size of your digital camera 
image (and increase its resolution) without losing any of its quality. Here’s the trick:

Resizing Digital 
Camera Photos
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Step Three:
If we plan to output this photo to any 
printing device, it’s pretty clear that we’ll 
need to increase the resolution to get 
good results. I wish we could just type 
in the resolution we’d like it to be in the 
Resolution field (such as 200 or 240 ppi),  
but unfortunately this “resampling” 
makes our low-res photo appear soft  
(blurry) and pixelated. That’s why we 
need to turn off the Resample check
box (it’s on by default). That way, when 
we type in a Resolution setting that we 
need, Photoshop automatically adjusts 
the Width and Height of the image down 
in the exact same proportion. As your 
Width and Height come down (with 
Resample turned off), your Resolution 
goes up. Best of all, there’s absolutely  
no loss of quality. Pretty cool!

Step Four:
Here I’ve turned off Resample and  
I entered 240 in the Resolution field for 
output to a color inkjet printer. (I know, 
you probably think you need a lot more 
resolution, but you don’t. In fact, I never 
print with a resolution higher than 240 
ppi.) This resized my image to nearly 
12x18" so it’s just about perfect for print-
ing to my Epson Stylus Photo R2880 
printer, which makes up to 13x19"-sized 
prints—perfect!
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Step Five:
Here, I’ve lowered the Resolution setting 
to 180 ppi. (Again, you don’t need nearly 
as much resolution as you’d think, but  
180 ppi is pretty much about as low as 
you should go when printing to a color 
inkjet printer.) As you can see, the Width 
of my image is now almost 24" and the 
Height is now almost 16". Best of all,  
we did it without damaging a single  
pixel, because we were able to turn off 
Resample, which normally, with things  
like scans, we couldn’t do.

Step Six:
When you click OK, you won’t see the 
image window change at all—it will ap-
pear at the exact same size onscreen—
but look at the rulers. You can see that 
it’s now almost 16" high by almost 24" 
wide. Resizing using this technique does 
three big things: (1) it gets your physi-
cal dimensions down to size (the photo 
now fits easily on a 16x24" sheet); (2) it 
increases the resolution enough so you 
can output this image on a color inkjet  
printer; and (3) you haven’t softened, 
blurred, or pixelated the image in any 
way—the quality remains the same—all 
because you turned off Resample. Note: 
Do not turn off Resample for images that 
you scan on a scanner—they start as high-
res images in the first place. Turning Re
sample off like this is only for low-res 
photos taken with a digital camera.
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Step One:
Here’s a low-resolution 72-ppi image we 
want to resize to a high-enough resolu-
tion to make a print of it. Go under the 
Image menu and choose Image Size to 
bring up the Image Size dialog (by the 
way, the Image Size dialog is resizable).  
You can see our image has a resolution  
of just 72 pixels per inch (or ppi, for short). 
Make sure the Resample checkbox is 
turned on and then choose Preserve 

Details (Enlargement) from the Resam
ple pop-up menu. When you do this, a 
Reduce Noise slider appears beneath the 
menu that might come in handy if you no-
tice that the noise gets increased along 
with the size of your photo (but using it 
adds a little blurring, so use it gingerly). 
By the way, you can compare different 
sizing methods by pressing Option-1– 

Option-7 (PC: Alt-1–Alt-7) to toggle 
through the different Resample options.

Smarter Image 
Upsizing (Even for Low-

Res Images)

Another thing I love that Adobe’s engineers do in each new version of Photoshop  
is that they go back and make existing features even better. In Creative Cloud, they 
came up with a new option for upsizing images (making them larger using  
the Image Size dialog) with a new mathematical algorithm for upsizing your image 
while maintaining more detail and sharpness than ever before (and this includes  
better results from upsizing a low-res 72 ppi image).
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Step Two:
Now, in the Resolution field, enter the 
new resolution you want. Here, we’ll enter 
300 ppi (if you don’t want to change the 
resolution, you can just type in new physi-
cal dimensions instead, a resize percent-
age, or both). The preview window shows 
you how the image is going to look at 
its new size or resolution. That’s it! In the 
Before and After shown below, you can 
see how much more detail and sharpness 
is now maintained after the upsize. One 
last thing: if you resize to some particular 
sizes a lot, you can save your own custom 
size presets. Just go under the Fit To pop-
up menu and choose Save Preset.

Before: Here’s the upsize using the old method

After: Here’s the new method. Much better!
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Step One:
Go under the File menu, under Scripts, 
and choose Image Processor. By the way, 
if you’re working in Adobe Bridge (rather 
than Photoshop), you can Command-click 
(PC: Ctrl-click) on all the photos you want 
to apply the Image Processor to, then go 
under the Tools menu, under Photoshop, 
and choose Image Processor. That way, 
when the Image Processor opens, it  
already has those photos pegged for  
processing. Sweet!

Step Two:
When the Image Processor dialog opens,  
the first thing you have to do is choose 
the folder of photos you want it to “do 
its thing” to by clicking on the Select 
Folder button, then navigating to the 
folder you want and clicking Choose (PC: 
OK). If you already have some photos 
open in Photoshop, you can click on the 
Use Open Images radio button (or if you 
chose Image Processor from Bridge, the 
Select Folder button won’t be there at 
all—instead it will list how many photos 
you have selected in Bridge). Then, in the 
second section, decide whether you want 
the new copies to be saved in the same 
folder or copied into a different folder.  
No big whoop (that’s a technical term).

Automated Saving  
and Resizing

If you have a bunch of images that you need resized, or converted from TIFFs  
to JPEGs (or from PSDs to JPEGs, for that matter), then you will love the built-in  
Image Processor. It’s kind of hidden in a place you might not expect it (under  
the Scripts menu), but don’t let that throw you—this is a really handy, and  
really easy-to-use, totally automated tool that can save you tons of time.



The Adobe Photoshop Book for Digital Photographers (2014 Release) 

How to Resize and Crop Photos 127Chapter 4

Step Three:
The third section is where the fun begins. 
This is where you decide how many cop-
ies of your original you’re going to wind 
up with, and in what format. If you turn on 
the checkboxes for Save as JPEG, Save 
as PSD, and Save as TIFF, you’re going to 
create three new copies of each photo. If 
you turn on the Resize to Fit checkboxes 
(and enter a size in the Width and Height 
fields), your copies will be resized, too (in 
the example shown here, I chose a small 
JPEG of each file, then a larger TIFF, so 
in my folder I’d find one small JPEG and 
one larger TIFF for every file in my origi-
nal folder).

Step Four:
In the fourth section, if you’ve created an 
action that you want applied to your cop-
ies, you can also have that happen auto-
matically. Just turn on the Run Action  
checkbox, then from the pop-up menus, 
choose which action you want to run. If 
you want to automatically embed your 
copyright info into these copies, type 
your info in the Copyright Info field. Lastly, 
there’s a checkbox that lets you decide 
whether to include an ICC profile in each 
image or not (of course, I’m going to try  
to convince you to include the profile, 
because I included how to set up color 
management in Photoshop in the bonus 
Print chapter found on the book's com-
panion webpage). Click the Run button,  
sit back, and let it “do its thing,” and  
before you know it, you’ll have nice, 
clean copies aplenty.
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Resizing for  
Poster-Sized Prints

So, since you saw earlier how much resolution you need to have to create a  
decent-sized print, how do photographers get those huge poster-sized prints  
without having super-high-megapixel cameras? It’s easy—they upsize the images  
in Photoshop, and the good news is that unless you need to resize your image  
by more than 300%, you can do this all right in Photoshop without having to  
buy a separate resizing plug-in (but if you need more than a 300% size increase,  
that’s where those plug-ins, like OnOne Software’s Perfect Resize, really pay off).

Step One:
Open the photo you want to resize, then 
go under the Image menu and choose 
Image Size or press Command-Option-I 

(PC: Ctrl-Alt-I). When the Image Size  
dialog appears, to the right of the Width 
field, you’ll see a pop-up menu where 
Inches is chosen. Click on that menu and 
choose Percent (as shown here). Both 
the Width and Height will change to  
Percent, because they’re linked together 
by default. Then, turn on the Resample 
checkbox at the bottom.

Step Two:
Now, type in either 200% or 300%  
(although there is some debate about  
this, it seems to work best if you move  
up/down in 100% increments) in the 
Width field (again, since they’re linked,  
the Height field will automatically change 
to the same number).
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Step Three:
At the bottom of the dialog is a pop-up 
menu that decides which algorithm is 
used to upsize your photo. The default  
is Automatic, and I use that for most  
everyday resizing stuff, but when it comes 
to jumping in big increments, like 200% 
or 300%, I switch to Bicubic Smoother 
(which Adobe says is “best for enlarge-
ment”), as shown here. 

Step Four:
Vincent Versace breaks this rule. 
According to Vincent’s research, the  
key to his resizing technique is to not 
use the sampling method Adobe recom-
mends (Bicubic Smoother), but instead  
to choose Bicubic Sharper, which he 
feels provides better results. So, which 
one is the right one for you? Try both on 
the same image (that’s right—just do  
a test print), and see if you can see a 
visible difference. Here’s the final image 
resized to around 25x16" (you can see 
the size in the rulers by pressing Com-

mand-R [PC: Ctrl-R]).
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Step One:
Open the photo that needs straight-
ening, click on the Crop tool (C) in the 
Toolbox, and then click on the Straighten 
tool up in the Options Bar. 

Step Two:
Now, find something in your photo  
that’s supposed to be straight or rela-
tively straight (the ledge, in this example). 
Click-and-drag the Straighten tool hori-
zontally along this straight edge in your 
photo, starting from the left and extend-
ing to the right (as shown here). 

Straightening  
Crooked Photos

Adobe has been tweaking the way we straighten images for the past  
few versions of Photoshop. It now has the fastest and easiest way yet,  
and it’s built right into the Crop tool’s options.
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Step Three:
When you release the mouse button, 
your photo rotates the exact amount  
to perfectly straighten the photo. One 
nice feature here is that it automatically  
resizes the cropping border, so that 
when you lock in your crop, you don’t 
have any gray gaps in the corners (if 
you ignore the cropping border, and 
look at the whole image now, see those 
triangular gray areas? Those would be 
white if Photoshop didn’t crop in like 
this). Now, just press the Return (PC: 
Enter) key to lock in your straightening, 
and it straightens and crops the image 
down to just what you see inside the 
cropping border (the final straightened 
image is shown here below).
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Downsizing photos where the  
resolution is already 300 ppi: 
Although earlier we discussed how to 
change image size if your digital camera  
gives you 72-ppi images with large physi
cal dimensions (like 24x42" deep), what 
do you do if your camera gives you 300-
ppi images at smaller physical dimensions 
(like 12x8" at 300 ppi)? Basically, you turn 
on the Resample checkbox (in the Image 
Size dialog under the Image menu), then 
simply type in the desired size (in this 
example, we want a 6x4" final image size), 
and click OK (don’t change the Resolu-
tion setting, just click OK). The image will 
be scaled down to size, and the resolu-
tion will remain at 300 ppi. IMPORTANT: 
When you scale down using this method, 
it’s likely that the image will soften a little 
bit, so after scaling, you’ll want to apply 
the Unsharp Mask filter to bring back  
any sharpness lost in the resizing (go to 
Chapter 9 to see what settings to use).

Making Your  
Photos Smaller 

(Downsizing)

There’s a different set of rules we use for maintaining as much quality as possible  
when making an image smaller, and there are a few different ways to do just that 
(we’ll cover the two main ones here). Luckily, maintaining image quality is much 
easier when sizing down than when scaling up (in fact, photos often look dramatically 
better—and sharper—when scaled down, especially if you follow these guidelines).
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Making one photo smaller without 
shrinking the whole document:
If you’re working with more than one 
image in the same document, you’ll  
resize a bit differently. To scale down  
a photo on a layer (like this photo of a  
cellist, which is on its own layer), first 
click on that photo’s layer in the Layers  
panel, then press Command-T (PC: 

Ctrl-T) to bring up Free Transform (it 
puts little handles around your image 
on that layer, kind of like what the Crop 
tool does). Press-and-hold the Shift key 
(to keep the photo proportional), grab 
a corner handle, and drag inward (here, 
I’ve grabbed the top-right corner handle 
and dragged inward to shrink the image). 
When the size looks good, press Return 

(PC: Enter). If the image looks softer 
after resizing it, apply the Unsharp Mask 
filter (again, see Chapter 9 for settings) 
to bring that sharpness back.

TIP: Reaching the Free  
Transform Handles
If you drag an image from one open  
document to another (like I did here, 
where I dragged the original cellist photo 
over onto the photo of the cello on the  
street), there’s a pretty good chance you’ll 
have to resize the dragged image, so it 
fits within your other image. And, if the 
image is larger (as in this case), when 
you bring up Free Transform, you won’t 
be able to reach the resizing handles 
(they’ll extend right off the edges of 
the document). Luckily, there’s a trick to 
reaching those handles: just press Com-

mand-0 (PC: Ctrl-0), and your window 
will automatically resize so you can reach 
all the handles—no matter how far out-
side your image area they once were. 
Two things: (1) This only works once you 
have Free Transform active, and (2) it’s 
Command-0—that’s the number zero, 
not the letter O.
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Resizing problems when  
dragging between documents:
This one gets a lot of people, because  
at first glance it just doesn’t make sense. 
You have two documents open, and they 
look approximately the same size (as 
seen here, at top), but when you drag the 
stained glass photo onto the blank docu-
ment, the stained glass photo appears 
really small (as seen below). Why? Al-
though the documents appear to be the 
same size, they’re not. The stained glass 
photo is a low-resolution, 72-ppi (pixels 
per inch) image, but the blank document  
is a high-resolution, 300-ppi image. The 
tip-off that you’re not really seeing them 
at the same size is found in each photo’s 
title bar. Here, the stained glass image 
is displayed at 100%, but the Untitled-1 
document is displayed at only 25% (so, 
it’s much larger than it appears). The key 
is that when you’re dragging images be-
tween documents, they need to be the 
same size and resolution.

TIP: Automated Cropping  
& Straightening
Want to save time the next time  
you’re scanning prints? Try gang  
scanning (fitting as many photos on  
your flatbed scanner as you can and 
scanning them as one big single image), 
and then you can have Photoshop auto
matically straighten each individual 
image and place it into its own separate 
document. You do this by going under 
the File menu, under Automate, and 
choosing Crop and Straighten Photos. 
No dialog will appear. Instead, Photo-
shop will look for straight edges in your 
photos, straighten the photos, and copy 
each into its own separate document.
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Step One:
Create a new document at 8x10" and 
240 ppi. Open a digital camera image, 
get the Move tool (V), and drag-and-
drop it onto the new document, then 
press Command-T (PC: Ctrl-T) to bring 
up Free Transform (if you can't see all the 
handles, press Command-0 [zero; PC: 

Ctrl-0]). Press-and-hold the Shift key, then 
grab a corner point and drag inward to 
scale the image down, so it fits within the 
8x10" area (as shown here on top), and 
press Return (PC: Enter). Now, in the 
image on top, there’s white space above 
and below the photo. If you want it to fill 
the 8x10 space, you could use Free Trans-
form to stretch the image to do so, but 
you’d get a stretched version of the jet 
(seen at bottom). This is where Content-
Aware Scale comes in.

We’ve all run into situations where our image is a little smaller than the area  
where we need it to fit. For example, if you resize a digital camera image so  
it fits within a traditional 8x10" image area, you’ll have extra space either above  
or below your image (or both). That’s where Content-Aware Scaling comes in— 

it lets you resize one part of your image, while keeping the important  
parts intact (basically, it analyzes the image and stretches, or shrinks,  
parts of the image it thinks aren’t as important). Here’s how to use it:

Resizing Just Parts  
of Your Image  
Using “Content- 
Aware” Scaling
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Step Two:
Go under the Edit menu and choose Con-

tent-Aware Scale (or press Command-

Option-Shift-C [PC: Ctrl-Alt-Shift-C]). 
Grab the top handle, drag straight up-
ward, and notice that it stretches the sky 
upward, but pretty much leaves the jet 
intact. Grab the bottom handle and drag 
downward, and it again stretches the sky. 
When you’ve dragged far enough, press 
Return (PC: Enter) to lock in your change. 
(Note: The button that looks like a person 
in the Options Bar tells Content-Aware  
Scale that there are people in the photo, 
so it tries to avoid stretching anything  
with a skin tone.) 

Step Three:
There are two more controls you need 
to know about: First, if you try Content-
Aware Scale and it stretches your subject 
more than you want, get the Lasso tool (L)  

and draw a selection around your subject 
(as shown here), then go under the Select 
menu and choose Save Selection. When  
the Save Selection dialog appears, just 
click OK and press Command-D (PC: 

Ctrl-D) to Deselect. Then bring up Con-
tent-Aware Scale again, but this time, go 
up in the Options Bar and choose your 
selection from the Protect pop-up menu 
(as shown here) to tell Photoshop where 
your subject is. Now you can drag up or  
down to fill the empty space with the 
least possible stretching.
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Step Four:
There’s also an Amount control up in  
the Options Bar, which determines how 
much stretching protection is provided. 
At its default of 100%, it’s protecting as  
much as possible. At 50%, it’s a mix of  
protected resizing and regular Free Trans
form, and for some photos that works best.  
The nice thing is the Amount control is live, 
so as long as your handles are still in place, 
you can lower the Amount and see live 
onscreen how it affects your resizing.
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Step One:
Start by opening a wide image, and then 
go under the Window menu and choose 
Actions to bring up the Actions panel. 
Click on the Create New Action icon at 
the bottom of the panel (it looks like the 
Create a New Layer icon in the Layers 
panel and is circled in red here) and, 
when the New Action dialog appears, 
name your new action “Wide Portfolio,” 
then click the Record button.

Step Two:
Now it’s recording what you’re doing,  
so go under the Image menu, choose 
Image Size, and resize your image, so 
it’s about 1200 pixels wide by 800 pixels 
tall, and then click OK. Next, press the 
square Stop Recording icon at the bottom 
of the Actions panel to stop recording (as 
shown here). Okay, that’s one action done.

Conditional Actions  
(At Last!)

Actions are basically tape recordings that live inside of Photoshop and you can  
use them to automate boring, repetitive tasks. Actions have been in Photoshop  
for many years now and ever since they were added, users have been asking for  
the ability to have conditional actions (meaning, a step in the recording where you  
can insert a condition, like “if this particular thing exists, then do this instead”).  
For example, if you wanted to have one action that properly resizes both your wide and 
your tall images for your online portfolio, you’d want your action to be  

“conditional” (if it’s wide, run this action; if it’s tall, run this one instead).
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Step Three:
Next, open a tall image and do the same 
thing, but name this action “Tall Portfolio” 
and, in the Image Size dialog, make this 
one 532 pixels wide by 800 pixels tall. 
Click OK, then click the Stop Recording 
icon. Now we have our two actions, so 
we can use those to make our conditional 
action in the next step.

Step Four:
Click on the Create New Action icon, 
once again, name this one “Resize for 
Portfolio,” and click the Record button. 
Now, go right to the Actions panel’s flyout 
menu and choose Insert Conditional (as 
shown here). This is where we tell Photo
shop which action to run if it opens a wide 
image and which one to run if it opens 
a tall image. So, no matter what their ori-
entation, they’ll wind up being 800 pixels 
tall, so they look uniform side-by-side in 
our portfolio. You’ll see that you have a 
bunch of different conditions to choose 
from in the Conditional Action dialog 
(also shown here).
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Step Five:
For our project, here, from the If Current 
(meaning, the currently open document) 
pop-up menu, we’re going to chose Doc

ument Is Landscape, and if that’s the 
case, from the Then Play Action pop-up 
menu, choose the Wide Portfolio action 
you made earlier. Finally, from the Else 
Play Action pop-up menu, choose Tall 

Portfolio. Click OK, and then click the 
Stop Recording icon at the bottom of  
the Actions panel.

Step Six:
Now, to apply this conditional action 
to a folder full of images, go under the 
File menu, under Automate, and choose 
Batch (we use Batch to process an entire 
folder of images at one time automati-
cally). When the dialog appears, in the 
Play section at the top left, choose the 
Resize for Portfolio conditional action 
you just created in the previous step from 
the Action pop-up menu. Then, choose 
the folder you want to run this action on 
(click the Choose button in the Source 
section), choose Save and Close from the 
Destination pop-up menu (or if you want 
them to be resized and saved in a differ-
ent folder, choose Folder and then pick 
the folder you want them to be moved 
into after you’ve resized them), and then 
click the OK button at the top right.

Step Seven:
Once the batch runs, even though the 
folder had both wide and tall images, 
you’ll see that the height of all the im-
ages is exactly the same. Again, this  
is just one use for conditional actions, 
but now you know how to create them 
(they’re pretty easy, right?), and now 
that you know, you can start creating 
smarter actions. S
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Photoshop Killer Tips

Instant Background Layer Unlocking

This is one of those little tips that just 
makes you smile. To instantly turn your 
Background layer into a regular layer with
out having a dialog pop up first, just click-
and-drag the little lock icon to the right of 
the word “Background” straight into the 
trash (thanks to Adobe’s Julieanne Kost for 
sharing this one).

Get Your Channel Shortcuts Back
Back in CS3, and all earlier versions of 
Photoshop, you could look at the indivi
dual color channels for a photo by pressing 
Command-1, Command-2, Command-3, 
and so on (on a PC, you’d use Ctrl-1, Ctrl-2,  
etc., instead). In CS4, they changed the 
shortcuts, which totally bummed out a lot of 
longtime users, but you have the option of 
bringing those glory days of channel short-
cuts back to the pre-CS4 era. Go under the  
Edit menu, choose Keyboard Shortcuts, 
then near the top of the dialog, turn on the 
Use Legacy Channel Shortcuts checkbox.

Set Defaults in Layer Styles
You can set your own custom defaults  
for layer styles like Drop Shadow or Glow. 
All you have to do is create a new layer in 
the Layers panel by clicking on the Create 
a New Layer icon, then choose the layer 
style you want from the Add a Layer Style 
icon’s pop-up menu (like Outer Glow, for 
example). In the Layer Style dialog, enter 
your own settings (like changing the glow 
from yeech yellow to white, or black, or 
anything but yeech yellow), then click  

on the Make Default button near the 
bottom of the dialog. To return to the 
factory default (yeech) settings, click  
the Reset to Default button.

How to Know if You Used the “Blend 
If” Sliders on a Layer
Photoshop now adds an icon on the right 
of any layer where you’ve adjusted the 
Blend If sliders in the Blending Options 
of the Layer Style dialog. The icon looks 

like two little overlapping squares, but it’s 

more than an icon—it’s a button. Double-
click on it and it brings up the Blend If slid-
ers in the Layer Style dialog. 

Layer Mask from Layer Transparency
Here’s a nice time saver: you can make 

the transparent areas of any layer into a 
mask in just one step: go under the Layer 
menu, under Layer Mask, and choose 
From Transparency.

One Click to Close All Your Tabs
If you’re using the Tabs feature (all your 

documents open as tabs), then you’ll defi-
nitely want to know this tip: to close all your 
open tabs at once, just Right-click on any 
tab and choose Close All.

Seeing Your Final Crop  
in Camera Raw
When you crop a photo in Camera Raw, 
you can see the final cropped image 
without having to open the image in 
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Photoshop Killer Tips

Photoshop. Once your cropping border  
is in place, just change tools and you’ll  
see the cropped version (in some previous 
versions, the cropped away area was still 
visible; it was just dimmed).

Save 16-Bit to JPEG
Back in CS4, if you worked with 16-bit 
photos, when you went to the Save dialog 
to save your photo, there was no option 
to save your image as a JPEG, because 
JPEGs have to be in 8-bit mode, so you’d 
have to close the dialog, convert to 8-bit, 
then go and Save again. That has changed 
and JPEG is now a choice, but what it does 
is makes a copy of the file, which it con-
verts to 8-bit, and saves that instead. This 
leaves your 16-bit image still open on-
screen and unsaved, so keep that in mind. 
If you want to save the 16-bit version sepa-
rately, you’ll need to save it as a PSD or 
TIFF like before. For me, once I know it has 
saved an 8-bit JPEG, I don’t need the 16-
bit version any longer, so I close the image 
and click the Don’t Save button, but again, 
that’s just me.

Lens Corrections Grid
If you’re using Camara Raw’s Lens Correc
tions panel to do things like straighten 
buildings or flatten rounded horizon lines, 
press the letter V on your keyboard, and 
an alignment grid appears over your image 
to help you line things up. To hide it again, 
press V again.

Assign a Keyboard Shortcut  
to the Color Picker
You can assign a keyboard shortcut to 
bring up the Foreground (or Background) 
Color Picker (this is handier than it sounds). 
Go under the Edit menu, under Keyboard 
Shortcuts, and from the Shortcuts For 
pop-up menu, choose Tools. Then scroll 
down near the bottom, and you’ll see 
Foreground Color Picker and Background 
Color Picker. Click on whichever one you 
want, and type in the shortcut you want.  
I have to tell you up front: most of the  
good shortcuts are already taken (in fact, 
almost all combinations of shortcuts are 
already taken), but my buddy Dave Cross  
came up with a good idea. He doesn’t use  
the Pen tool all that much, so he used the 
letter P (for Picker). When you enter “P,” 
it’s going to warn you that it’s already 
being used for something else, and if you 

click the Accept and Go to Conflict  
button at the bottom left, it assigns P 
to the Color Picker you chose, and then 
sends you to the Pen tool to choose a 
new shortcut. If you don’t need to assign 
one to the Pen tool (you don’t use it 
much either), then just leave it blank  
and click OK.

Visual Way to Change Your  
Brush Size and Softness
This is incredibly handy, because you can 
actually see and control the exact size 
and amount of softness for your current 
brush tip. Press-and-hold Option-Ctrl 
(PC: Alt-Ctrl) then click-and-drag (PC: 
Right-click-and-drag) up/down to control 
the softness/hardness of the brush, and 
left/right to control the size. 
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Working with Tabbed Documents
When working with multiple documents 
while using the Tabs features, to see any  
tabbed image, just click on its tab at the 
top of the image window or press Ctrl-

Tab to cycle through them one by one. To 
turn tabbing off, go under the Photoshop 

(PC: Edit) menu, under Preferences, and 
choose Interface, then turn off the Open 
Documents as Tabs checkbox. Also, you’ll 
probably want to turn off the Enable 
Floating Document Window Docking 
checkbox, too, or it will dock your single 
open image.

Setting Up Your Workspace
Photoshop comes with a number of 
built-in workspace layouts for different 
tasks with just the panels visible Adobe 
thought you’d need. You can find them 
by clicking on the pop-up menu at the 
right end of the Options Bar. To cre-
ate your own custom workspace layout, 
just click-and-drag the panels where you 
want them. To nest a panel (so they ap-
pear one in front of another), drag one 
panel over the other. When you see a 
blue outline appear, release the mouse 
button and it nests. More panels can be 
found under the Window menu. Once 

your panels are set up where you want 
them, go under the Window menu, under 
Workspace, and choose New Workspace, 
to save your layout so it’s always one click 
away (it will appear in the pop-up menu). 
Also, if you use a workspace and change a 
panel’s location, it remembers. That’s okay, 
but you’d think that clicking on your work-
space would return things to normal. It 
doesn’t. Instead, you have to go into that 
pop-up menu and choose Reset [your 
workspace name].

Getting Sharp Edges on  
Your Stroke Layer Effect
If you’ve applied a large stroke using the 
Stroke layer effect (under the Edit menu) or 
Stroke layer style (by clicking on the Add  
a Layer Style icon at the bottom of the Lay-
ers panel and choosing Stroke from the  
pop-up menu), you’ve probably already  
noticed that the edges start to get round
ed, and the bigger you make the stroke,  
the rounder they get. So, what’s the trick 
to nice, sharp straight edges? Just switch 
the Stroke position or location to Inside. 

White Balance Quick Fix
If you have an image whose white  
balance is way off, and you didn’t shoot  
it in RAW, try this: go under the Image 
menu, under Adjustments, and choose 
Match Color. When the Match Color dia
log appears, just turn on the Neutralize 
checkbox in the Image Options section.  
It works better than you’d think for most 
white balance problems (plus, you can 
write an action to do all that for you).

Change Ruler Increments
If you want to quickly change the unit of 
measure in your ruler (say, from pixels to 
inches or from centimeters to millimeters), 
just Right-click anywhere inside the Rulers  
and choose your new unit of measurement 
from the pop-up menu that appears.

Using “Scrubby Sliders”
Anytime you see a numerical field in 
Photoshop (like the Opacity field in the 
Layers panel, for example), you can change 
the setting without typing in a number, or 
dragging the tiny slider. Instead. click di-
rectly on the word “Opacity” and drag left 
(to lower the opacity) or right (to increase 
it). This is very fast, and totally addictive, 
and if you’re not using it yet, you’ve got to 
try it. There’s no faster way to make quick 
changes (also, press-and-hold the Shift key 
while using it, and it goes even faster).
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8-bit mode, 76, 142, 169
16-bit mode, 76, 142
18% gray card, 11
32-bit HDR images, 168–169
50% magnification, 288
100% view, 35, 48

A
about this book, xiv–xvii
actions

conditional, 138–140
high-contrast look, 248–251

Actions panel, 138, 248
Adaptation pop-up menu, 241
Adaptive Wide Angle filter, 221–224
Add Audio option, 316, 318, 341
Add Clips dialog, 309
Add Layer Mask icon, 40
Add Media option, 308, 331, 337
Adjust Edge sliders, 215
Adjustment Brush, 82

Auto Mask feature, 83, 84, 94
brush cursor display, 103
Clear All button, 104
color swatch additions, 104
contrast increased with, 90, 148
deleting adjustments made with, 83
dodging and burning with, 82–87, 359
doubling effects applied with, 102
drawing straight lines with, 103
Erase mode for, 86
hiding edit pins for, 104
killer tips about, 103–104
Mask checkbox, 84, 104
painting white balance with, 100
reducing shadow noise with, 101
resizing the brush, 89, 93, 104
retouching portraits with, 21, 89–90
selective color applied with, 93–94
softening skin with, 89
wet street effect with, 282–283

adjustment layers
Black & White, 146, 326, 348
Color Lookup, 274–275

Curves, 35
enlarging controls for, 303
Gradient Map, 150, 151, 153, 272–273
ignoring with Eyedropper tool, 350
layer masks and, 242
Levels, 35, 151, 327
Shadows/Highlights, 242
video projects and, 326–327, 348

Adjustments panel, 150, 151, 157, 272, 274
Adobe Bridge. See Bridge
Adobe Photoshop. See Photoshop CC
Adobe Photoshop Lightroom, 35
Adobe Premiere Pro, 306
Adobe RGB color space, 75
Adobe Standard profile, 5
aligning layers, 176, 202, 207
all-purpose sharpening, 292
Alpha channels, 233
Ambience slider, 271
Amount slider

Shadows/Highlights dialog, 191
Sharpening controls, 49
Smart Sharpen filter, 297, 298
Unsharp Mask dialog, 289, 293
Vignetting controls, 60, 61, 63

animation, video text, 334
Aperture Priority mode, 165
Application Frame, 217, 323
Arrow keys, 310, 311
Artifact Suppression slider, 227, 229
As Shot white balance, 8, 10
aspect ratio, 28
Audio settings dialog, 317, 318
audio tracks for video, 316–319

background music, 316–317, 341–343
narration or voice-over, 318–319

Auto button, Camera Raw, 17–19, 35, 78
Auto Mask feature, 83, 84, 94
Auto Save feature, 351
Auto Tone adjustments, 17
Auto-Align Layers function, 176, 202, 207
auto-correcting photos, 17–19
Automate options, 140

B
Background layer, 141
background music, 316–317
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backgrounds
blur effects for, 262–266
compositing selections and, 217–220

backlit subjects, 15, 190–192
Balance slider, 155
barrel distortion, 172
Batch dialog, 140
batch processing, 140
before/after previews, 32–33
Bicubic sampling methods, 129
bit depth, 76
Black & White adjustment layer, 146, 326, 348
Black & White view, Refine Edge dialog, 213
black-and-white conversions, 146–160

Camera Raw method for, 146–149
contrast added to, 147–148, 151
duotone effects and, 156
Merge to HDR Pro for, 302
painting with B&W, 93–94
photo toning effects and, 272–273
quadtone effects and, 157–158
Silver Efex Pro 2 plug-in for, 160
split-toning effects and, 154–155
three-click method for, 150–153

Blacks slider, 16, 19, 147, 357
blemish removal, 69, 88
Blend If sliders, 141
blend modes

Color, 195, 220
Color Burn, 196
Darken, 269
Hard Light, 183, 300
keyboard shortcuts for, 34
Overlay, 151, 183, 196, 216, 247, 250
pop-up menu for, 243
Screen, 242, 281
Soft Light, 151, 183, 185, 196, 247, 333, 336
toggling through, 196, 242, 336
video project, 335–336
Vivid Light, 248

blended HDR images, 174–177
blur

adding to backgrounds, 262–266
Blur Gallery effects, 259–266
Gaussian Blur effect, 185, 253
painting in Camera Raw, 103
reducing with Shake Reduction, 226–229
Surface Blur effect, 249

Blur Direction tool, 228
Blur Effects panel, 261
Blur Estimation tool, 229
Blur filter

Field Blur, 265–266
Iris Blur, 262–264
Tilt-Shift Blur, 259–261

Blur Gallery, 259, 262, 265
Blur slider, 260
Blur Tools panel, 260, 261, 263
Blur Trace Bounds slider, 227
bonus features

Adobe Bridge chapters, xvi
Curves chapter, xvii
Print chapter, 127
sample image files, xiv

Bracket keys ([ ])
blur length adjustments using, 228
reordering layers using, 285
resizing brushes using, 89, 93, 277
scrolling through layers using, 103

bracketed exposures, 165
Bridge

Camera Raw version in, 4
online bonus chapters on, xvi
opening JPEGs and TIFFs from, 2, 284

Brightness slider, 280
brush cursor, 103, 198
Brush Picker, 242
Brush tool

changing blend modes for, 243
eyeglass reflections and, 204
group shot fixes and, 208
HDR images and, 181, 183
HUD color picker and, 187, 243
opacity settings for, 349
selection cleanup and, 216
sharpening techniques and, 183, 300
special effects and, 247, 281
texture overlays and, 336

brushes
new maximum size for, 350
resizing, 89, 93, 104, 142, 276, 277, 349
softness/hardness setting, 142, 349

burning and dodging. See dodging and burning
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C
calibration, camera, 71
Camera Calibration panel, 71
Camera Landscape profile, 6
camera profiles, 5–6
Camera Raw, 2–35, 38–79, 82–104

Adjustment Brush, 82–87, 89, 93, 100, 102, 103
Auto corrections, 17–19, 35, 78
B&W conversions in, 146–149
before/after previews in, 32–33
Blacks slider, 16, 19, 147, 357
Bridge version of, 4
calibrating for cameras, 71
camera profiles used in, 5–6
Camera Raw Filter option, 7
chromatic aberration fixes in, 58–59
Clarity slider, 20–21, 148, 178, 357
clipping warning, 13–14
color profile assignments, 79
color range adjustments, 66–67
contrast adjustments, 22–27
Contrast slider, 13, 147, 178, 355, 360
cropping photos in, 28–30, 141–142
Default button, 17, 34
deleting photos in, 34
DNG conversion in, 64–65
dodging and burning in, 82–87, 359
double-processing in, 38–43
edge vignetting and, 60–63
editing multiple photos in, 44–46
Exposure slider, 12, 99, 355, 359
Full Screen mode, 35, 78
Graduated Filter tool, 91–92, 358
HDR image processing in, 178–179
Highlights slider, 14, 148, 178, 356
histogram in, 79
JPEG and TIFF images in, 2–3, 4, 44
killer tips about, 34–35, 78–79, 103–104
lens correction features, 52–57, 58–59, 60
localized corrections in, 82
Noise Reduction feature, 72–74, 78, 187
opening photos in, 2–3, 284
panorama adjustments in, 254–255
perspective fixes in, 54–57
photography workflow, 354–361
portrait retouching in, 88–90
Preferences dialog, 17, 48, 65
Presets panel, 23, 159

Preview area in, 34, 35
Radial Filter tool, 95–99
rating photos in, 35
Shadows slider, 14–15, 148, 178, 356
sharpening photos in, 47–51, 301
skipping the window for, 34
Snapshots panel, 103
special effects using, 93–99, 282–283
Spot Removal tool, 35, 68–69, 70
straightening photos in, 31
Temperature slider, 9–10
Tint slider, 9–10
Tone Curve panel, 22–27, 148
Vibrance slider, 43, 358
Visualize Spots feature, 70
White Balance settings, 8–11
Whites slider, 16, 19, 147, 357
Workflow Options dialog, 75–77
See also RAW images

Camera Raw Filter, 7
camera shake fixes, 226–229
Camera Standard profile, 5–6
cameras. See digital cameras
Canon cameras, 5, 6, 164
canvas

adding around images, 112
rotating for tablets, 78

capture sharpening, 47
cast shadows, 243
cell phones

designing for, 285
photo noise reduction, 187

Channel pop-up menu, 26, 27
channels

adjusting individual, 26–27
keyboard shortcuts for, 141

Channels panel, 290
Character panel, 333
chromatic aberration, 58–59
Clarity slider

Adjustment Brush, 86, 89, 101, 102, 282
Camera Raw Basic panel, 20–21, 148, 178, 357

Classic mode options, 109
Clear All button, 104
Clear Crop option, 29
clipping warnings, 13–14
Clone Stamp tool, 235, 360
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color
changing for guides, 243
composite photo, 219–220
converting to B&W, 146–160
filling selections with, 219
lighting effects and, 270
range adjustments in Camera Raw, 66–67
sampling with Eyedropper, 194, 219
selective, 93–94
setting to none, 103
text/title, 333

Color blend mode, 195, 220
Color Burn blend mode, 196
color cast, 26, 71, 270
color channels

adjusting individual, 26–27
keyboard shortcuts for, 141

color correction
online chapter about, xvii
RGB curves for, 26–27

Color Detail slider, 73
Color Lookup adjustment layer, 274–275
color noise reduction, 72–73, 74
Color Picker

Adjustment Brush, 103, 104
B&W conversions and, 152
Fade with Color transition and, 321
Graduated Filter tool, 91
HUD pop-up version of, 187, 243
keyboard shortcut assignment, 142
text/title color and, 333
video graphic bar and, 322

Color Priority vignetting, 63
color profiles, 79
Color Range dialog, 350–351
Color slider, 72–73
Color Smoothness slider, 74
color space configuration, 75
color swatches, 104, 270
color warning triangles, 14
Colorize swatch, 270
composite images, 217–220

color adjustments, 219–220
detail enhancement, 218
fringe removal, 218

conditional actions, 138–140
constrained cropping, 28

Constraint lines, 221, 222–224
Constraint tool, 222, 223
Contact Sheet II automation, 349
Content-Aware Fill

distracting object removal, 234–239
off-limit item selections, 238
panorama adjustments, 257
tips for using, 302
wide-angle photo fixes, 225

Content-Aware Move, 240–241
Content-Aware Scale

resizing parts of images, 135–137
stretching/shrinking parts of images, 230–233

contrast
black-and-white conversions and, 147–148, 151
Curves for adjusting, 22–27
HDR image creation and, 171
high-contrast portrait look, 248–251
increasing midtone, 20–21
Levels for adjusting, 327
TAT for targeting, 25

Contrast slider
Adjustment Brush, 90, 282
Camera Raw Basic panel, 13, 147, 178, 355, 360
Merge to HDR Pro dialog, 171
Radial Filter tool, 96

Convert for Smart Filters option, 190, 209, 221, 242, 
328

Convert to Grayscale checkbox, 146, 154, 156
Convert to Smart Object option, 209
copyright information, 127, 303
Create Warped Text icon, 334
Crop indicator icon, 30
Crop Shield, 110
Crop tool (Camera Raw), 28–30
Crop tool (Photoshop), 108–117

Auto-Align function and, 176
cropping border, 108
Delete Cropped Pixels option, 113
HDR image creation and, 173
Lights Out cropping option, 110
Original Ratio option, 112
Rule of Thirds overlay grid, 108
size and resolution options, 114–115
standard size options, 110
Straighten tool, 130–131
tool presets, 116–117
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cropping photos, 108–117
aspect ratio and, 28
Camera Raw option for, 28–30, 141–142
and canceling crops, 111
canvas area added for, 112
creating custom tools for, 116–117
flipping the orientation for, 111
histogram accuracy by, 79
lens distortion fixes and, 56, 173
Lights Out mode for, 110
overview of process for, 108–113
panorama creation and, 256–257
preset sizes for, 110
resolution setting for, 114, 115
rotating and, 109
rule of thirds and, 35, 108
sizing/resizing and, 114–115
straightening and, 31, 130–131, 134
vignetting and, 62–63
wide-angle shots, 221, 222

Cross, Dave, 142
Cross Fade transitions, 320, 340–341, 343–344
cross-processing effect, 27
curved line straightening, 224
Curves

Auto adjustment button, 35
color corrections using, xvii, 26–27
contrast adjustments using, 22–27
HDR Pro dialog box, 167
online chapter about, xvii
RGB channel fixes using, 26–27
saving as presets, 23, 27
TAT used with, 25

Curves adjustment layer, 35
Custom crop option, 29

D
dark circle removal, 68–69
Darken blend mode, 269
Darks slider, 24
Decontaminate Colors checkbox, 215
Default button, Camera Raw, 17, 34
Defringe dialog, 218
Defringe sliders, 59
Delete key, 29, 34

deleting
adjustments, 83
cropped pixels, 113
empty layers, 187
hidden layers, 351
layer masks, 217
lights, 269
photos, 34
presets, 120
See also removing

Density slider, 87
Desaturate command, 246, 250
desaturated portrait effect, 246–247
Deselect command, 195, 219, 225, 233
Detail icon, 47, 72
Detail Loupe, 226, 227–228, 229
Detail panel, 51
Detail slider

Camera Raw, 50
Merge to HDR Pro dialog, 167

Detect Faces checkbox, 351
digital cameras

calibrating Camera Raw for, 71
camera profiles for, 5
HDR setup for, 164–165
hiding info from, 303
lens profiles for, 52–53
reducing shake from, 226–229
resizing photos from, 121–123
white balance settings, 8, 100

digital photography workflow, 354–361
distortion fixes

Geometric Distortion Correction checkbox, 255
Lens Corrections panel, 54–57, 172

Distortion slider
Blur Tools panel, 261
Lens Corrections panel, 56, 172, 239, 258

distracting object removal, 234–239
DNG (Digital Negative) format

converting RAW files to, 64–65, 302
setting preferences for, 65

DNG Profile Editor utility, 6
Document Frame Rate option, 345
documents

duplicating specs for creating, 186, 284
presets for creating, 119–120

Dodge and Burn tools, 197–200
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dodging and burning
in Camera Raw, 82–87, 359
in Photoshop CC, 197–200

double-processing images, 38–43
downloadable images, xiv
downsizing photos, 132–133
Drag to Apply dialog, 320, 321, 324, 334
dragging-and-dropping

photos from Bridge, 161
size/resolution issues with, 134
title slides into videos, 331

dramatic lighting effect, 267–271
drawing straight lines, 103
dreamy focus effect, 252–253
drop shadows, 187, 243, 325
dull gray skies, 193–196
duotone effects, 156, 158
Duotone Options dialog, 158
duplicating layers, 186, 197, 199, 218, 246
Duration options

video clip, 313
video transition, 320, 321, 324

E
Edge Glow sliders, 166
Edge Smoothness feature, 170, 174, 180
edge vignetting, 60–63

adding, 61–63
HDR image, 184
post-crop, 63, 184
Radial Filter for, 95–99
removing, 60, 255

edit pins, 104
editing

JPEGs and TIFFs in Camera Raw, 4
multiple photos, 44–46
transitions in movies, 321
video clips, 314–315, 337

effects. See special effects
emailed photos, 79
Embed Fast Load Data checkbox, 65
empty layers, 187
Enable Keyframe Animation control, 334
Enable Lens Profile Corrections checkbox, 52, 60
Erase mode, Adjustment Brush, 86
Esc key, 29, 31, 111
EXIF data, 5, 53, 60, 71

Expand Selection dialog, 194
Content-Aware Fill and, 225, 234, 257, 302
Content-Aware Move and, 240

exposure adjustments
Adjustment Brush, 85, 86, 89
black-and-white conversions and, 147
Camera Raw Basic panel, 12–16
workflow example of, 355–357

Exposure slider
Adjustment Brush, 85, 86, 89, 101, 283
Camera Raw Basic panel, 12, 99, 355, 359
Graduated Filter tool, 91, 92
Lighting Effects filter, 270
Merge to HDR Pro dialog, 167, 169, 171
Radial Filter tool, 95, 96, 97, 98

Eye icon, 103, 176, 247, 270, 275
eye retouching, 89–90, 161
Eyedropper tool

channel adjustments and, 26
ignoring adjustments using, 350
ring appearing around, 194
sampling colors with, 194, 219, 350

eyeglass reflections, 201–205

F
Fade In/Out options

for audio, 317, 342
for video transitions, 320–321, 324

Fade Iris Blur option, 264
Fade with Black transition, 321, 341
fashion photography, 274–275
Feather slider

Adjustment Brush, 87
Radial Filter tool, 98
Vignetting controls, 63

Field Blur effect, 265–266
File Handling options, 351
File Info dialog, 303
Fill dialog

Content-Aware Fill, 225, 235, 236, 257
tips for displaying, 161

Fill field, Layers panel, 243
Film & Video preset, 322, 330
filmstrip, 3, 30, 34, 35, 44
filters

Adaptive Wide Angle, 221–224
Camera Raw, 7
Field Blur, 265–266
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Gaussian Blur, 185, 253
High Pass, 182, 299
Iris Blur, 262–264
Lens Correction, 52, 186
Lens Flare, 242, 280–281
Lighting Effects, 267–271
Liquify, 209–210, 276–279
Radial, 95–99
Reduce Noise, 78
Shake Reduction, 226–229
smart, 190, 192, 221
Smart Sharpen, 297–298
Surface Blur, 249
Tilt-Shift Blur, 259–261
Unsharp Mask, 252, 288–294, 328, 360
video feature and, 328–329

finding specific photos, 79
fixing problem photos, 190–241

backlit subjects, 190–192
composite images for, 217–220
Content-Aware features for, 230–241
distracting object removal, 234–239
dodging and burning for, 197–200
dull gray skies, 193–196
eyeglass reflections, 201–205
group shot fixes, 206–208
Liquify filter for, 209–210
making tricky selections, 211–216
moving stuff naturally for, 240–241
Shake Reduction filter for, 226–229
stretching/shrinking parts of images, 230–233
wide-angle shots, 221–225

Flashlight preset, 268
Flatten button, 157
Flatten Image command, 42, 331
flattening layers, 42, 157, 225, 243, 256
Flip Horizontal option, 217
Flow slider, 87
Focus option, 261
Forward Warp tool, 209, 276
Frame Rate pop-up menu, 345
Free Transform

creating cast shadows with, 243
Flip Horizontal option, 217
reaching the handles of, 133, 230
resizing photos with, 133, 135, 217, 230, 338, 350
rotating layers with, 203
Show Transform Controls option, 350
video titles/text and, 330, 333

Freeze Mask tool, 279
fringe removal, 218
Full Upright option, 56
full-screen view, 35, 78
Fuzziness slider, 351

G
Gamma slider, 167
gang scanning images, 134
Gaussian Blur filter, 185, 253
Geometric Distortion Correction checkbox, 255
ghosting problems, 180–181
glasses, fixing reflections in, 201–205
Gloss slider, 271
Go to First Frame icon, 310
Google Nik Collection, 160
Gradient Editor dialog, 151, 152, 273
gradient effects

neutral density, 91, 358
photographic toning, 273
sky adjustments, 91–92, 195

Gradient Map adjustment layer, 150, 151, 153,  
272–273

Gradient tool, 195
Graduated Filter tool, 91–92, 358
graphic bar, 322–325
gray card, 11
gray skies, 193–196
grayscale conversions. See black-and-white 

conversions
Grayscale mode, 150, 157
grids

Lens Corrections panel, 142, 186
rule-of-thirds, 35, 108

group shot fixes, 206–208
groups

layer, 349
video, 332

guides, preferences for, 243

H
hair selections, 211–216
halos around images, 297
Hand tool, 302, 303
Hard Light blend mode, 183, 300
hardness of brushes, 142, 349
Harrington, Richard, 329
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HDR images, 163–185
32-bit, 168–169
blended, 174–177
Brush tool and, 181, 183
camera setup for, 164–165
Edge Smoothness feature, 170, 174, 180
finishing techniques for, 184–185
Gaussian Blur added to, 185
ghosting problems in, 180–181
High Pass sharpening for, 182–183
Merge to HDR Pro dialog for, 166–167
presets for creating, 166, 170–171
processing in Camera Raw, 178–179
realistic look for, 168–169
sharpening techniques for, 182–183, 184
single-image technique for, 178–179
time saving tip for creating, 186
tone-mapped look for, 170–173
vignettes applied to, 184

HDR Pro feature. See Merge to HDR Pro dialog
Healing Brush tool, 34, 237, 360
Height slider, 271
hiding

edit pins, 104
panels, 187

High Dynamic Range images. See HDR images
High Pass filter, 182, 299
High Pass sharpening

HDR images and, 182–183
steps for applying, 299–300

High Structure preset, 160
high-contrast portrait look, 248–251
Highlight Priority vignetting, 63, 184
highlights

adjusting in photos, 14, 191
clipping warning for, 13–14
split-toning effects and, 154–155

Highlights slider
Adjustment Brush, 101
Camera Raw Basic panel, 14, 148, 178, 356
Merge to HDR Pro dialog, 167, 171, 174
Tone Curve panel, 24, 25

histogram, 79
History panel, 103
Hollywood, Calvin, 248
Horizontal Type tool, 346
hot spot removal, 34–35
Hotspot slider, 270

HSL/Grayscale panel, 66–67, 146, 154, 156
HUD pop-up Color picker, 187, 243
Hue/Saturation adjustments

duotone effects and, 156
split-toning effects and, 154–155

Hughes, Bryan O’Neil, 295

I
image downloads, xiv
Image Processor dialog, 126–127
Image Size dialog, 121–123, 124–125, 128–129, 132
Infinite Light style, 270
input sharpening, 301
Intensity slider, 270
Inverse command, 192
Invert command, 249, 274
Iris Blur effect, 262–264
iStockPhoto, 335

J
JPEG files

editing in Camera Raw, 4, 9
opening in Camera Raw, 2–3, 44, 284
saving 16-bit images as, 142

K
kelbyone.com website, xiv, xvi
keyboard shortcuts

blend mode, 34
brush size, 89, 93
channel, 141
Color Picker, 142
Full Screen mode, 35
layer functions, 243, 285
Radial Filter tool, 96
video controls, 310, 311, 313
zooming in/out, 32, 277, 288

keyframe animation, 334
Kost, Julieanne, 141
Kuler utility, 187

L
Lasso tool, 136, 234, 236
layer blend modes. See blend modes
Layer Comps to PDF script, 349
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layer masks
adjustment layers and, 242
copying between layers, 243
creating from transparencies, 141
fixing photo problems using, 203–204, 208
HDR processing with, 177, 181, 183
permanently applying, 217
sharpening using, 183
smart filters and, 192
texture overlays and, 336

Layer Style dialog, 322
layer styles

applying to multiple layers, 349
Drop Shadow, 187, 325
setting defaults for, 141
Stroke, 322

layers
aligning, 176, 202, 207
deleting empty, 187
duplicating, 186, 197, 199, 218, 246
filter bar for showing/hiding, 349
flattening, 42, 157, 225, 243, 256
grouping, 349
inverting, 249
locking multiple, 303
merged, 247, 249
opacity settings for, 202
removing hidden, 351
renaming multiple, 186
reordering, 285
rotating, 203
scaling photos on, 133
scrolling through, 103
searching for, 349–350
video files on, 309, 337
viewing/hiding, 103, 176, 349
See also adjustment layers

Layers panel
Attribute options, 351
Eye icon, 103, 176
Fill field, 243

Left/Right Arrow keys, 311
Lens Correction filter, 52, 186
Lens Corrections icon, 52, 60, 172
Lens Corrections panel

alignment grid, 142
chromatic aberration fixes, 58–59
edge vignetting adjustments, 60–63

panorama adjustments, 258
perspective fixes, 54–57, 239
profile-based fixes, 52–53
Upright feature, 54–57

lens flare effect, 280–281
Lens Flare filter, 242, 280–281
lens problems

Camera Raw fixes for, 52–57, 58–59, 60
wide-angle photos and, 221–225

lens profiles, 52–53
Levels adjustment layer, 35, 151, 327
lighting, dramatic, 267–271
Lighting Effects filter, 267–271
Lightroom, Photoshop, 35
Lights Out cropping mode, 110
Lights panel, 267, 270
Lights slider, 24
Linear curve, 23
Liquify filter, 276–279

Advanced Mode options, 278–279
brush resizing methods, 276, 277
Forward Warp tool, 276–277
Freeze and Thaw Mask tools, 279
retouching tip using, 284
smart objects and, 209–210

Local Adaptation HDR mode, 166
localized corrections, 82
locking layers, 303
logos, adding to video, 340
lossy compression, 65
Loupe, Detail, 226, 227–228, 229
lower third options, 322–325
Luminance Contrast slider, 73
Luminance Detail slider, 73
luminance noise reduction, 73
Luminance slider, 73

M
Magic Wand tool, 193, 212, 225, 257
Mask checkbox, Adjustment Brush, 84, 104
Masking slider, 50, 51
Match Color dialog, 143
Matting options, 218
maximum sharpening, 291
Medium Contrast curve, 22
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Merge to HDR Pro dialog
32-bit mode, 168–169
Advanced sliders, 167, 174
B&W image creation in, 302
Edge Glow section, 166
Edge Smoothness checkbox, 170, 174, 180
presets in, 166, 170–171
quick tour of, 166–167
Remove Ghosts checkbox, 166, 180–181
tip on saving time in, 186
Tone and Detail section, 167
See also HDR images

Merge Visible command, 243
merged layers, 247, 249
Metallic slider, 271
Midpoint slider, 60, 61, 63
midtone contrast adjustments, 20–21
miniaturization effect, 259–261
Mobile & Devices preset, 285
moderate sharpening, 291
Motion dialog, 339
Move tool

composite images and, 217
cropped photos and, 30, 113, 115
group shot adjustments and, 207
lens flare effect and, 281
video text and, 330, 331, 333, 346, 347
See also Content-Aware Move

movies. See video
music for video, 316–317, 341–343
Mute Audio checkbox, 317, 343
muting background music, 317

N
naming/renaming

multiple layers, 186
video projects, 344

narration for video, 318–319
negative clarity, 21, 89
Nelson, Felix, xvii
neutral density gradient effects, 91, 358
neutral gray card, 11
New Action dialog, 138, 248
New dialog, 115, 119, 186, 284, 322
New Document Preset dialog, 120
New Preset dialog, 23, 159

New Smart Object via Copy option, 39
Nik Collection, 160
Nikon cameras, 5, 6, 164
noise reduction, 72–74, 78, 101, 124, 187, 229
Noise Reduction slider, 101
numerical field settings, 143

O
one-click presets, 159
OnOne Software, 128
Opacity settings

B&W conversions and, 153
blurred layers and, 253
Brush tool and, 349
Color Lookup effect and, 274
composite images and, 220
cropping process and, 110
HDR images and, 177
multiple layers and, 202, 218
scrubby sliders for, 143
sharpening techniques and, 183, 295, 300
special effects and, 247, 251
spot removal and, 35
video title/text, 333
wrinkle removal and, 68

Open dialog, 3
Open Image button, 4, 29
Open Object button, 38–39
output sharpening, 301
Overlay blend mode, 151, 183, 196, 216, 247, 250
Overlay view, Refine Edge dialog, 214

P
Paint Overlay vignetting, 63
painting

B&W effect, 93–94
noise reduction, 101
sharpness, 296
straight lines, 103
white balance, 100

Pan & Zoom option, 339
panels

temporarily hiding, 187
workspace layout for, 143
See also specific panels
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panoramas, 254–258
Camera Raw adjustments for, 254–255
Content-Aware Fill for, 257
cropping to size, 256–257
lens corrections for, 258
Photomerge for creating, 255–256
vignette removal for, 255

Parametric curve, 24–25
Paste in Place command, 161
Patch tool, 236, 237
Path Bar, Bridge, 3
patterns/textures, 335–336
PDF Presentation automation, 349
Pen tool, 142
Perfect Resize plug-in, 128
perspective fixes, 54–57, 172
photo toning effects, 272–273
photography workflow, 354–361
Photomerge feature, 255–256
Photoshop CC

photography workflow, 354–361
preference replacement, 284
RAM allocation, 285
Sync Settings, 118
UI appearance options, 78–79

Photoshop for Video (Harrington), 329
“Photoshop Killer Tips” sections, xvii
Photoshop Lightroom, 35
Pixel Grid option, 186
Place Embedded command, 335
Play icon, 314, 317, 320, 339
playhead, 307, 310
plug-ins

disabling third-party, 186
Perfect Resize plug-in, 128
Silver Efex Pro 2 plug-in, 160

Point curve, 22–23, 26
Point Lights, 269
Polygon Constraint tool, 224
portraits

desaturated, 246–247
high-contrast, 248–251
retouching, 68–69, 88–90, 284
sculpting, 276–279
sharpening, 290

post-crop vignettes, 63, 184

poster-sized prints, 128–129
preferences

Bridge, 4
Camera Raw, 17, 48, 65
rebuilding in Photoshop, 284

Premiere Pro, 306
Preserve Cropped Pixels option, 30
Preserve Details (enlargement) option, 124
Preset Manager dialog, 117, 242
presets

B&W conversion, 160
cropping, 110, 114, 116–117
Curves, 23, 27
deleting, 120
document, 119–120
duotone, 158, 159
Film & Video, 322, 330
HDR image, 166, 170–171
Levels, 327
lighting effect, 268
Mobile & Devices, 285
one-click, 159
Photographic Toning, 273
tool, 116–117
video format, 344–345
white balance, 9
workflow, 77

Presets panel, 23, 159
Preview area, Camera Raw, 34, 35
Preview Preferences dialog, 33
previews

before/after, 32–33
video, 312, 329

printing
bonus chapter on, 127
poster-sized prints, 128–129
resolution settings for, 122
sharpening images for, 301

profiles
camera, 5–6
color, 79
lens, 52–53

Protect Details checkbox, 295
Protect Skin Tones button, 231
Protect Tones checkbox, 200



 374 Index

The Adobe Photoshop CC Book for Digital Photographers (2014 Release) 

Q
quadtone effects, 157–158
Quick Selection tool, 40, 192, 193, 211–213, 233

R
Radial Filter tool, 95–99
Radius slider

Edge Glow feature, 166
High Pass filter dialog, 182, 299
Refine Edge dialog, 213–214
Refine Mask dialog, 42
Shadows/Highlights dialog, 191
Sharpening controls, 49
Smart Sharpen filter, 297
Unsharp Mask dialog, 289, 293

RAM
assigning to Photoshop, 285
video feature and, 306

rating photos, 35
RAW images

auto-correcting, 17–19
camera calibration for, 71
camera profiles for, 5–6
chromatic aberration fix, 58–59
Clarity applied to, 20–21
color profile assignments, 79
color range adjustments, 66–67
contrast adjustments, 22–27
converting to DNG format, 64–65, 302
cropping, 28–30
double-processing, 38–43
edge vignetting in, 60–63
editing multiple, 44–46
exposure adjustments, 12–16
giving to clients, 302
gradient effects, 91–92
histogram for, 79
lens corrections, 52–57
noise reduction, 72–74
opening in Camera Raw, 2, 3, 284
panorama adjustments as, 254
retouching, 88–90
saving as DNGs, 64–65
sharpening, 47–51
spot removal, 70
straightening, 31

white balance adjustments, 8–11
workflow settings, 75–77
See also Camera Raw

realistic-looking HDR images, 168–169
Reconstruct tool, 210
recording actions, 138–140
rectangle straightening, 224
Rectangular Marquee tool, 322
Recycle Bin icon, 79
Red channel sharpening, 290, 295
Red Eye tool, 161
red-eye removal, 161
Reduce Noise filter, 78
Reduce Noise slider, 124, 297, 298
Refine Edge dialog, 213–215
Refine Mask dialog, 42
Refine Radius tool, 214
reflections, eyeglass, 201–205
Regions of Interest, 228
Remember Settings checkbox, 213
Remove Ghosts checkbox, 166, 180–181
removing

chromatic aberration, 59
distracting objects, 234–239
edge vignetting, 60, 255
eyeglass reflections, 201–205
fringe in composites, 218
red-eye problems, 161
spots and specks, 70
See also deleting

renaming. See naming/renaming
Render Video dialog, 344, 345
rendering bar for video, 329
Resample checkbox, 122, 123, 124, 128, 132
Reset Gradients option, 273
Resize to Fit checkbox, 76, 127
resizing. See sizing/resizing
resolution

Crop tool field for, 114, 115
image size and, 119–125, 132, 134
print, 122
web, 121

Restore All button, 277
retouching portraits

Camera Raw techniques for, 68–69, 88–90
Photoshop Liquify filter for, 276–279, 284

RGB curve adjustments, 26–27
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Rotate View tool, 78
rotating

canvas, 78
crops, 109
layers, 203
photos, 78
views, 78

Roundness slider, 63
rule-of-thirds cropping, 35, 108
rulers

displaying, 121
unit-of-measure changes, 143

Run Action checkbox, 127

S
sampling colors in photos, 194, 219
Saturation slider

Adjustment Brush, 85, 93, 103
Merge to HDR Pro dialog, 167

Save As Defaults button, 192
Save Image button, 64, 285, 301
Save Mask to Channels checkbox, 261
Save Options dialog, 64, 285, 302
Save Selection dialog, 233
saving

16-bit photos to JPEG, 142
Auto Save feature for, 351
automated resizing and, 126–127
Camera Raw defaults, 47
RAW files as DNGs, 64–65
selections, 136, 233, 238
video projects, 344

scaling
content-aware, 135–137, 230–233
lighting effects, 268, 269
photos on layers, 133
See also sizing/resizing

Scott5 HDR Pro preset, 170–171, 174
Screen blend mode, 242, 281
scrolling credits, 346–347
scrubbing video clips, 312, 314
scrubby sliders, 143
sculpting portraits, 276–279
S-curves, 27
Select All button, 30, 45, 46
Select Rated button, 79

selections
deselecting, 212, 233
edge-of-document, 303
expanding, 194, 225
filling with color, 219
inversing, 192
Liquify filter, 284
making tricky, 211–216
saving, 136, 233, 238
skin tone, 350–351
viewing, 213, 214

selective color, 93–94
sepia-tone images, 156, 273
Set Additional Crop Options icon, 109, 110
Set Start/End of Work Area bar, 311
Set White Point Preview histogram, 168
shadows

adjusting in photos, 14–15, 190–192
creating cast, 243
drop, 187, 243, 325
duotones and, 156
noise reduction and, 78, 101
split-toning effects and, 154–155

Shadows slider
Adjustment Brush, 101
Camera Raw Basic panel, 14–15, 148, 178, 356
Merge to HDR Pro dialog, 167, 171, 174
Radial Filter tool, 98
Tone Curve panel, 24

Shadows/Highlights adjustment layer, 242
Shadows/Highlights dialog, 190–192
Shake Reduction filter, 226–229
Sharpen tool, 295–296
Sharpening sliders, 49–51
sharpening techniques, 288–301

Camera Raw and, 47–51, 301
Channels panel and, 290
dreamy focus effect, 252
essentials of, 288–294
HDR images and, 182–183
High Pass sharpening, 182–183, 299–300
noise reduction and, 229
Opacity settings and, 183, 295, 300
output sharpening, 301
portrait sharpening, 290
print sharpening, 301
sample settings, 289–294
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sharpening techniques (continued)
Shake Reduction filter, 226–229
Sharpen tool and, 295–296
Smart Sharpen filter, 297–298
soft subjects and, 290
video and, 328
web graphics and, 292
workflow example of, 360

Sharpness slider, Adjustment Brush, 89
Shift Edge slider, 42
shortcuts. See keyboard shortcuts
Show Cropped Area checkbox, 110
Show Grid checkbox, 186
Show Mask checkbox, 279
Show Overlay option, 35
Show Transform Controls checkbox, 350
side-by-side previews, 32
Silver Efex Pro 2 plug-in, 160
single-image HDR look, 178–179
sizing/resizing

automated saving and, 126–127
brushes, 89, 93, 104, 142, 276, 277, 349
conditional actions for, 138–140
cropping and, 114–115
default setting for, 350
digital camera photos, 121–123
downsizing process and, 132–133
dragging photos and, 134
Free Transform used for, 133, 135, 217,  
230, 338, 350
interpolation method for, 350
parts of images, 135–137, 230–233
photos on layers, 133
poster-sized prints, 128–129
Preview area, 35
RAW images, 76
resolution and, 119–125, 132, 134
thumbnails, 312
tip for speeding up, 350
upsizing process and, 124–125

skin softening, 21, 89
skin tone selections, 350–351
sky adjustments, 91–92, 193–196
smart filters, 190, 192, 221, 328
smart objects

creating new via copy, 39
double-processing images using, 39–40
dragged-and-dropped images as, 161

Liquify filter used as, 209–210
opening images as, 39, 41, 76
page icon indicating, 39
setting preferences for, 161
video clip conversion into, 328

Smart Radius checkbox, 42, 213
Smart Sharpen filter, 297–298
Smooth tool, 210
Smoothing slider, 229
snapshots, 103
Snapshots panel, 103
soft glow finishing, 185
Soft Light blend mode, 151, 183, 185, 196,  

247, 333, 336
soft spotlight effect, 60–61
soft subject sharpening, 290
softening skin, 21, 89
softness of brushes, 142, 349
Sony cameras, 164
Source Noise pop-up menu, 229
Spacebar

Hand tool accessed with, 302, 303
playing video with, 317, 320, 339

special effects, 246–283
Camera Raw used for, 93–99, 282–283
Color Lookup effects, 274–275
desaturated skin look, 246–247
dramatic lighting effect, 267–271
dreamy focus effect, 252–253
Field Blur effect, 265–266
high-contrast portrait look, 248–251
Iris Blur effect, 262–264
lens flare effect, 280–281
panorama creation, 254–258
photo toning effects, 272–273
sculpting with Liquify filter, 276–279
selective color, 93–94
tilt shift effect, 259–261
video projects and, 348
wet street effect, 282–283, 360

Split at Playhead icon, 318, 319, 342
split-screen previews, 33
split-toning effects, 154–155
Spot Healing Brush, 236, 237, 238–239
Spot Removal tool, 35, 68–69, 70, 88
spot/speck finding feature, 70
Spring Loaded Tools, 285
sRGB color space, 75, 79
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star ratings, 35, 79
straight lines, 103
Straighten tool

Camera Raw, 31
Photoshop, 130–131

straightening
automated cropping and, 134
Camera Raw tool for, 31
curved lines, 224
lens perspective problems, 54–57
Photoshop tool for, 130–131
rectangles, 224

streets, wet look for, 282–283
Strength slider, 166, 174
stretching parts of images, 230–233
Stroke layer style, 143, 322
Strong Contrast curve, 22, 148
Surface Blur filter, 249
Symmetric Distortion checkbox, 261
Sync Settings, 118
Synchronize dialog, 45
synchronizing edits, 45–46

T
Tab key, 187
tablets, designing for, 285
Tabs feature, 141, 143
Targeted Adjustment tool (TAT), 25

color range adjustments using, 66–67
contrast adjustments using, 25

Temperature slider
Adjustment Brush, 100
Camera Raw Basic panel, 9–10

text
scrolling, 346–347
video project, 325, 330–334, 340, 346
warp animation, 334

Texture pop-up menu, 271
textures/patterns, 335–336
Thaw Mask tool, 279
third-party plug-ins, 186
three-click B&W conversion, 150–153
Threshold slider, 289, 294
thumbnails

layer mask, 217
resizing, 312
Timeline panel, 312, 339

TIFF files
editing in Camera Raw, 4, 9
opening in Camera Raw, 2–3, 44, 284

Tile All Vertically option, 323, 331
tilt shift effect, 259–261
Timeline panel, 307, 308, 310–313, 339
Tint slider

Adjustment Brush, 85
Camera Raw Basic panel, 9–10

titles/text for videos, 330–334, 340, 346
tonal corrections, 17
Tone Curve panel, 22–27, 148
tone-mapped HDR look, 170–173
Tool Presets panel, 116–117
tools

fast switching between, 285
resetting to defaults, 302
See also specific tools

Transition icon, 320, 324, 334, 340, 341
transitions, video

adding, 320–321, 340–341
editing, 321, 344

Trash icon, 79
tricky selections, 211–216
trimming video clips, 314–315, 337
Triple Scoop Music, 316, 341
tritone effects, 157
type

scrolling, 346–347
video project, 325, 330–334, 340, 346
warp animation, 334

Type tool, 325, 330, 332

U
UI appearance options, 78–79
Undo command, 17, 238, 277, 302
Unsharp Mask filter

dreamy focus effect and, 252
essentials of using, 288–294
HDR image sharpening and, 184
sample settings, 289–294
video projects and, 328
workflow example using, 360
See also sharpening techniques

unwanted object removal, 234–239
Up/Down Arrow keys, 310
Upright feature, 54–57



 378 Index

The Adobe Photoshop CC Book for Digital Photographers (2014 Release) 

upsizing images, 124–125
Use Classic Mode checkbox, 109
Use Legacy option, 298
user interface options, 78–79

V
Versace, Vincent, 129
Vertical Upright option, 55
Vibrance slider

Camera Raw Basic panel, 43, 358
Merge to HDR Pro dialog, 167

video, 306–348
adjustment layers in, 326–327, 348
audio options for, 316–319, 341–343
basic controls for, 310–313
blend modes used in, 335–336
effects applied to, 348
file format presets for, 344–345
filters used in, 328–329
graphic bar creation, 322–325
important points about, 306–307
keyboard shortcuts, 310, 311, 313
motion effects added to, 339
music added to, 316–317, 341–343
narration or voice-over for, 318–319
opening in Photoshop, 308–309
ordering clips for, 312, 338, 343
photos added to, 338–339
previewing, 312, 329
project workflow, 337–345
rendering bar for, 329
saving as movies, 344–345
scrolling credits for, 346–347
texture overlays in, 335–336
Timeline panel, 307, 308, 310–313
title and text options, 330–334, 340, 346
transitions for, 320–321, 340–341, 343–344
trimming, 314–315, 337

Video Groups, 332
viewing

before/after previews, 32–33
full-screen images, 35
selections, 213, 214

vignette effects
adding, 61–63
HDR image, 184
post-crop, 63, 184
Radial Filter for, 95–99
removing, 60, 255

Vignetting slider, 60
visual brush resizing, 276
Visualize Spots feature, 70
Vivid Light blend mode, 248
voice-over for video, 318–319
Volume slider, 318

W
Wacom tablets, 78, 284
warning triangles, 14
Warp Text dialog, 334
web-based book resources, xiv, xvi
websites

color space for, 79
image resolution for, 121
sharpening photos for, 292, 301

Weinrebe, Steve, 272
wet street effect, 282–283, 360
White, Terry, 156
White Balance adjustments

Auto function for, 19
Camera Raw options for, 8–11, 19
gray card used for, 11
Match Color dialog for, 143
painting with white balance, 100

White Balance pop-up menu, 11
White Balance tool, 10–11
Whites slider, 16, 19, 147, 357
wide-angle photo fixes, 221–225
Workflow Options dialog, 75–77, 79
Workflow presets, 77
workflow process

for photography projects, 354–361
for video projects, 337–345

workspaces, 143
wrinkle removal, 68
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X
XMP files, 65, 302

Y
YouTube video presets, 344–345

Z
zoom pop-up menu, 79
Zoom tool, 20

chromatic aberration and, 58
click-and-drag option, 161
red-eye removal and, 161
sharpening and, 35, 48

zooming in/out, 32, 277, 288
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